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RightFax 9.3 End User License Agreement

IMPORTANT-READ CAREFULLY: This End User License Agreement
(“EULA") is a legal agreement between you (either an individual or a single
entity) and Captaris, Inc. (“Captaris”) for the Captaris software product
identified above, which includes computer software and may include
associated media, printed materials, and “online” or electronic documentation
(“Product”).

YOU AGREE TO BE BOUND BY THE TERMS OF THIS EULA BY
INSTALLING, COPYING OR OTHERWISE USING THE PRODUCT, IN
WHOLE OR PART. IF YOU DO NOT AGREE TO THE TERMS OF THIS
EULA, DO NOT INSTALL, COPY OR USE THE PRODUCT. INSTEAD, YOU
SHOULD PROMPTLY CONTACT CAPTARIS FOR INSTRUCTIONS ON
RETURN OF THE PRODUCT.

IF YOU HAVE NOT PAID A LICENSE FEE FOR THE PRODUCT, THEN YOU
HAVE ACQUIRED AN EVALUATION EDITION OF THE PRODUCT, WHICH
IS GOVERNED BY THIS EULA, EXCEPT THAT YOUR RIGHT TO USE THE
PRODUCT AS AN EVALUATION EDITION IS LIMITED TO TWO (2) USER
ACCOUNTS AND THE WARRANTIES AND CERTAIN OTHER
PROVISIONS OF THIS EULA DO NOT APPLY AS STATED BELOW. YOUR
RIGHT TO USE THE EVALUATION EDITION UNDER THIS EULA WILL
AUTOMATICALLY TERMINATE AND THE PRODUCT WILL
AUTOMATICALLY CEASE FUNCTIONING THIRTY (30) DAYS AFTER YOU
INSTALL IT UNLESS YOU PURCHASE A LICENSE AND ACTIVATE THE
PRODUCT BEFORE THE END OF SUCH THIRTY (30) DAY PERIOD. THE
COMPONENTS OF THE PRODUCT ARE LICENSED SEPARATELY AND,
EXCEPT FOR AN EVALUATION EDITION, YOUR LICENSE RIGHTS
UNDER THIS EULA EXTEND ONLY TO THE COMPONENTS OF THE
PRODUCT FOR WHICH YOU HAVE PAID THE LICENSE FEE.

AS THE FIRST STEP IN THE INSTALLATION PROCESS, WE
RECOMMEND THAT YOU INSTALL AND RUN THE PREREQUISITE
APPLICATIONS DISK AS DESCRIBED IN THE DOCUMENTATION. IF YOU
DO NOT INSTALL AND RUN THE PREREQUISITE APPLICATIONS DISK,
THEN THE WARRANTIES CONTAINED IN THIS EULA WILL NOT APPLY
TO THE PRODUCT. THE PREREQUISITE APPLICATIONS DISK
INCLUDES PROGRAMS OWNED BY THIRD PARTIES (“THIRD PARTY
PROGRAMS"). THE THIRD PARTY PROGRAMS ARE SUBJECT TO THIS
EULA AND ANY SEPARATE LICENSE AGREEMENTS THAT ACCOMPANY
SUCH PROGRAMS, EXCEPT THAT THE THIRD PARTY PROGRAMS ARE
FURNISHED BY CAPTARIS “AS IS” AND WITHOUT ANY WARRANTIES
OF ANY KIND, EXPRESS OR IMPLIED.

Server Software License

Subject to the terms and conditions herein, Captaris grants you a
non-exclusive, non-transferable, personal license to install, run and use one
copy of the server software provided as part of the Product on a single server
that is owned or controlled by you for use in the capacity for which you have
paid license fees. For purposes of this EULA, the capacity licensed by you is
determined based on the number of ports (also referred to as channels), seats,
CPUs, user accounts, or other capacity limitations on which software pricing is
based. As an exception to the restriction set forth in the first sentence of this
section on the number of servers on which the server software may be
installed, you may install, run and use the following server software
components on an unlimited number of servers owned or controlled by you;
provided, you have paid the license fee for such software and such software is
used only with a properly licensed RightFax Server module: Workserver,
DocTransport, Sync, Production Service, Faxrpc, Exchange Gateway, SMTP
Gateway, Lotus Notes Gateway, WPO Gateway, SAP Gateway, Isolated
Engine Conversion, Java/XML module, and Lotus Notes module.



Client Software License

Subject to the terms and conditions herein, Captaris grants you a
non-exclusive, non-transferable, personal license to install, run and use the
client software provided as part of the Product on an unlimited number of client
computers or devices that are owned or controlled by you for use in the
capacity for which you have paid license fees and solely with the server
software properly licensed by you under this EULA.

Documentation

You may make and use a reasonable number of copies of any documentation
provided with the Product; provided, that such copies will only be used for
internal business purposes in connection with the components of the Product
for which you have paid the applicable license fees and are not to be
republished or redistributed (either in hard copy or electronic form) beyond
your premises.

Backup
You may make one copy of the Product for back-up and archival purposes.

Updates

Any software provided to you by Captaris which updates or supplements the
original Product is governed by this EULA unless separate license terms are
provided with such updates or supplements, in which case, such separate
terms will govern.

License Limitations

Except with respect to an Evaluation Edition, the preceding licenses apply only
to the extent you have ordered and paid for the applicable licenses. The
preceding sections state the entirety of your rights with respect to the Product.
Captaris reserves all rights not expressly granted to you in this EULA. Without
limiting the foregoing, you will not, and you will not authorize or permit any third
party to:

(a) use the Product for any purpose other than your internal business
purposes;

(b) use an Evaluation Edition for any purpose other than your evaluation and
testing of the Product during the thirty (30) day evaluation period;

(c) license, distribute, lease, rent, lend, transfer, assign or otherwise dispose of
the Product or use the Product in any commercial hosted or service bureau
environment;
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(d) reverse engineer, decompile, disassemble or attempt to discover the source
code for or any trade secrets related to the Product, except and only to the
extent that such activity is expressly permitted by applicable law
notwithstanding this limitation;

(e) modify, alter or create any derivative works of the Product;

(f) exceed the capacity or concurrent user limitations for the license purchased
by you; or

(g) remove, alter or obscure any copyright notice or other proprietary rights
notice on the Product;

(h) disclose the results of any benchmark testing using the Product to any third
party; or

(i) circumvent or attempt to circumvent any methods employed by Captaris to
control access to the components, features or functions of the Product.

Audit

Captaris shall have the right to audit your compliance with the terms of this
EULA. You agree to grant access to Captaris to facilities, equipment, books,
records and documents and to otherwise reasonably cooperate with Captaris
in order to facilitate any such audit.

Ownership

The Product is valuable property of Captaris and its suppliers and is protected
by copyright and other intellectual property laws and treaties. Captaris or its
suppliers own all right, title and interest in and to the Product and all copyright
and other intellectual property rights in the Product.

Limited Warranty

Provided that you installed and ran the prerequisite application disk in
accordance with the documentation provided with the Product, Captaris
warrants to you that the components of the Product for which you have paid
the applicable license fees will perform substantially in accordance with the
accompanying Product manual for a period of thirty (30) days from the date of
receipt. To the maximum extent permitted by applicable law, Captaris's and its
suppliers’ entire liability and your exclusive remedy for failure of the software to
conform to the foregoing warranty is, at Captaris's option, either (a) return of
the license fee paid by you for the nonconforming components of the Product
in exchange for return of the nonconforming components of the Product by
you, or (b) repair or replacement of the components of the Product that does
not meet the warranty. The foregoing warranty is void if the failure is due to
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accident, abuse or misapplication and does not apply to an Evaluation Edition
or the Third Party Programs. Any replacement Product will be warranted for the
remainder of the original warranty period, if any.

Indemnification

Captaris will defend you against any judicial proceeding based upon a third
party claim that the components of the Product for which you have paid the
applicable license fee infringes any U.S. patent, U.S. trademark, copyright or
trade secret and will indemnify you against any damages, judgments and costs
finally awarded against you in such proceeding; provided that, you: (a) give
Captaris prompt written notice of the claim; (b) permit Captaris to control the
defense and settlement of the claim; and (c) cooperate with Captaris in the
defense and settlement of the claim. Captaris's defense and indemnification
obligations will not apply to any actual or alleged infringement based upon: (i)
modification of the Product by anyone other than Captaris, (ii) abuse,
misapplication or casualty loss, (i) use of the Product in combination with any
other program or device, if such infringement would have been avoided but for
such modification or combination, or (iv) failure to install or use any error
corrections, fixes or other updates furnished by Captaris, if such infringement
could have been avoided by such installation or use. In the event any
component of the Product licensed by you or your use of such component is
held to infringe or in Captaris's reasonable judgment is likely to infringe any
third party intellectual property right, Captaris may, at its option, (x) obtain a
license for you to continue to use such component, (y) modify the component
so that it is noninfringing, or (z) terminate this EULA as it pertains to such
component and refund a portion of the license fee paid by you for such
component prorated over three (3) years from the date of purchase. The
foregoing indemnification obligations do not apply to an Evaluation Edition or
the Third Party Programs.

Disclaimer of Warranties

EXCEPT AS EXPRESSLY SET FORTH ABOVE, CAPTARIS AND ITS
SUPPLIERS PROVIDE THE PRODUCT “AS IS” AND WITH ALL FAULTS.
CAPTARIS AND ITS SUPPLIERS HEREBY DISCLAIM ALL OTHER
WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, ARISING BY LAW
OR OTHERWISE, INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE OR USE, TITLE AND NONINFRINGEMENT, WITH REGARD TO
THE PRODUCT. WITHOUT LIMITING THE FOREGOING, CAPTARIS
DOES NOT WARRANT THAT THE PRODUCT WILL BE FREE OF BUGS,
ERRORS, VIRUSES OR OTHER DEFECTS.

Disclaimer of Certain Damages

IN NO EVENT WILL CAPTARIS OR ITS SUPPLIERS BE LIABLE FOR THE
COST OF COVER OR FOR ANY INCIDENTAL, INDIRECT, SPECIAL,
PUNITIVE, CONSEQUENTIAL OR SIMILAR DAMAGES OR LIABILITIES
WHATSOEVER (INCLUDING, BUT NOT LIMITED TO LOSS OF DATA,
INFORMATION, REVENUE, PROFIT OR BUSINESS) ARISING OUT OF
OR RELATING TO THE USE OR INABILITY TO USE THE PRODUCT OR
OTHERWISE UNDER OR IN CONNECTION WITH THIS EULA OR THE
PRODUCT, WHETHER BASED ON CONTRACT, TORT (INCLUDING
NEGLIGENCE), STRICT LIABILITY OR OTHER THEORY EVEN IF
CAPTARIS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.

Limitation of Liability

CAPTARIS'S AND ITS SUPPLIERS' LIABILITY ARISING OUT OF OR
RELATING TO THE USE OR INABILITY TO USE THE PRODUCT OR
OTHERWISE UNDER OR IN CONNECTION WITH THIS EULA OR THE
PRODUCT IS LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR
THE PRODUCT REGARDLESS OF THE AMOUNT OF DAMAGES YOU
MAY INCUR AND WHETHER BASED ON CONTRACT, TORT (INCLUDING
NEGLIGENCE), STRICT LIABILITY OR OTHER THEORY. The foregoing
disclaimer of warranties, disclaimer of certain damages and limitation of liability
will apply to the maximum extent permitted by applicable law. The laws of some
states/jurisdictions do not allow the exclusion of implied warranties or the
exclusion or limitation of certain damages. To the extent that those laws apply
to this EULA, the exclusions and limitations set forth above may not apply to
you.
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Export Restrictions

You acknowledge that the Product is subject to U.S. export restrictions. You
agree to comply with all applicable laws and regulations that apply to the
Product, including without limitation the U.S. Export Administration
Regulations.

U.S. Government License Rights

All Product provided to the U.S. Government is provided with the commercial
license rights and restrictions described in this EULA. By installing, copying or
using the Product, the U.S. Government agrees that the Product is
“commercial computer software” or “commercial computer software
documentation” within the meaning of FAR Part 12.

Trademarks

This EULA does not grant you any rights in connection with any trademarks or
service marks of Captaris or its suppliers.

Termination

Without prejudice to any other rights, Captaris may terminate this EULA if you
do not abide by the terms and conditions contained herein. Upon termination of
this EULA, you must cease use of the Product and destroy all copies of the
Product and all of its component parts.

Transfer

You may not transfer your rights under this EULA to any third party.

Governing Law; Jurisdiction

Unless expressly prohibited by local law, this EULA is governed by the laws of
the State of Washington, U.S.A. without regard to any conflict of law principles
to the contrary. The 1980 U.N. Convention on Contracts for the International
Sale of Goods or any successor thereto does not apply. You hereby irrevocably
submit to jurisdiction of the state and federal courts located in King County,
Washington with respect to any proceeding under this EULA or relating to the
Product. You will not prosecute any action, suit, proceeding or claim arising
under or by reason of this EULA except in such courts.

Attorneys' Fees

In any action or proceeding to enforce rights under this Agreement, the
prevailing party will be entitled to recover costs and reasonable attorneys' fees.
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Severability

If any provision of this EULA is held by a court of competent jurisdiction to be
invalid, illegal, or unenforceable, the remainder of this EULA will remain in full
force and effect.

English Language

It is the express wish of the parties that this Agreement and all related
documents be drawn up in English. C'est la volonté expresse exigé par les
parties que cette convention et tous les documents y afférents, soient rédigés
en anglais seulement.

Entire Agreement

This EULA sets forth the entire agreement of Captaris and you with respect to
the Product and the subject matter hereof and supersedes all prior and
contemporaneous understandings and agreements whether written or oral. No
amendment, modification or waiver of any of the provisions of this EULA will be
valid unless set forth in a written instrument signed by the party to be bound
thereby.



Contents

Chapter 1

Chapter 2

Hardware and Software Requirements......c.ccersamssnssessans 9
Fax Server ReqUIremMents .......cvcreenennnsneesee s 9
Supported Versions of Microsoft SQL Server ........cccccvuneneee. 10
Fax Board Requirements.........ccoovcmniicnninnnissnsesieinins 12
Phone Line Requirements.......cooucnnicnninsnicsseseeenenns 12
What Is Installed on the RightFax Server?..........ccuuu.u. 15
RightFax Software.........ovnssssssssesses 15
RightFax Configuration Programs........ccccunnnnninininins 15
RightFax ServiCes ... 18
RightFax Registry Entries ..o 18
RightFax Client Applications ... 18

Chapter 3

Installing the RightFax Server Software.........ccecevuruene 19
Upgrading from a Previous Version of RightFax........c..cccev.... 19
OVEIVIBW ..ottt 20
Running the Prerequisites Wizard .........ccccvvincnnniinincinicnns 21
Installation OVEIVIEW .........ceireirieeereireneeneee s 24
Supported Database Collation ... 25
Running the Prerequisites Wizard .........ccocvvincnininiinincinicnns 25
Enabling Your Licensed Product Feature Set ........cccovueuene 28
Installing the Fax Board Drivers.......connnininicniciins 28
Installing the RightFax Web Applications..........cccovniniccinicnnns 29
Repairing the RightFax Server Installation ..........c.coovevcniennes 31
Uninstalling the RightFax Server ..., 31
Using Enterprise Fax Manager........ccovncnninisncnisinnins 33
Running Silent Installs of the Server

and Fax Board Drivers.......innncesee s 34

vii



Chapter 4

Chapter 5

Chapter 6

Chapter 7

Installing the RightFax Client Applications .................. 1
RightFax Client Computer Requirements .........c.ccvveerereencenenns 43
Upgrading the RightFax Client Applications ..........cccouvinienee. 43
Before You Begin......ccoisi s 44
RightFax Client Installation Methods.......ccccoeviniininiiniiniinnn, 45
Installing the Client Applications

from the RightFax CD ... 45
Installing the Client Applications

from a Network File Share ... 46
Creating an Automated Client Install .........ccoocvinininininnn, 46
Creating an Automated Client Uninstall.......cc.coocecinnniinnene, 48
Configuring Windows 2000 and 2003 Terminal Services to

Support RightFax Client SeSSIoNns.......ccoecenercenecenerneneen. 49
Troubleshooting the Client Installation

and Configuration ... 49
Installing RightFax in a Windows 2000
or Windows 2003 Cluster 53
Clustering RightFax with Microsoft

WiINdOWS 2000 SEIVET .....cvuiereecirireeiineseiseieesesessesesessesssssesenees 53
Clustering RightFax with Microsoft

WiINAOWS 2003 SEIVET .....cuvuieriecirireeiieeseiseseesessssesesessese s 61
Installing and Configuring RightFax Data Sharing..... 71
Data Sharing with RightFax 9.3........cccurinennnnnereeeneeeens 71
Server TOPOIOGY ... sseens 71
System ReqUIrEMENtS......oveeriririresreeeses e 73
Installing RightFax Servers to Share a SQL Database.......... 73
Performing Daily Maintenance ..o 75

Upgrading and Adding Fax Channels,

User Licenses, and Optional Components........c.ouuuuene 77
Checking for Installed Components.......cccoveeereerreerneeemneenenens 77
Upgrading the RightFax Server ... 78
Adding Fax Channels and User Licenses ........covvenernerneenn: 79
Licensing Brooktrout SR140 Channels .......ccoveenrencrnercnnn. 80

Enabling New RightFax Optional Components.........cccccvuuee.. 80

Chapter 8

RightFax 9.3 Feature Pack 1 Installation Guide

Documentation and Support 83
RightFax Documentation.........ciisiins 83
Getting Help Online......cocoiisssisesissss s 85
Captaris Training ServiCes......comnnsssens 85
Captaris Implementation ServiCes........coummenernereenerneneenns 86
CUSLOMEr SUPPOIt....ecreecerereererreer e seseees 86

viii



Chapter 1

Hardware and Software Requirements

Fax Server Requirements

Many of the software requirements associated with RightFax 9.3
are provided on the Prerequisites CD that is shipped with RightFax.
To determine the needs of your fax server, you must first run the
Prerequisites CD, which will in-turn launch the RightFax
Prerequisites Wizard. The Prerequisites Wizard must be run prior
to installing the RightFax server software and will perform a system
check for required third-party components and if necessary, will
install them to your system. Some components, such as Windows
service packs and Microsoft Exchange are not provided. For more
information see “Running the Prerequisites Wizard"on page 21 of
the installation guide.

Supported Windows Operating Systems
o Microsoft Windows Server 2003 Standard Edition
o Microsoft Windows Server 2003 Enterprise Edition
o Microsoft Windows Server 2003 Datacenter Edition
o Microsoft Windows 2000 Advanced Server with SP4 installed
e Microsoft Windows 2000 Server with SP4 installed
o Microsoft Windows 2000 Datacenter Server with SP4 installed

Minimum hardware requirements

Computer/Processor | 2.4 GHz or higher Pentium IV-compatible CPU
Memory 1 GB RAM
Hard drive 1.2 GB free space

CPU support

Single and dual CPU systems

Drive CD-ROM or DVD drive

Display SVGA or higher resolution monitor running at a
resolution of 800 x 600 or higher

Keyboard Required

Recommended hardware requirements

Computer/Processor | 3.6 GHz or higher Pentium IV-compatible CPU
Memory 2 GB RAM
Hard drive 2 GB free space

CPU support

Single and dual CPU systems

Drive

CD-ROM or DVD drive
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Display SVGA or higher resolution monitor running at a
resolution of 1024 x 768 or higher
Keyboard Required

Additional requirements

e Internet Explorer 6 SP1
« MDAC 2.8
o .NET Framework 1.1 or higher

All RightFax servers and remote BoardServer computers require
Microsoft Data Access Components (MDAC) version 2.8. If your
RightFax server has not been updated to use MDAC version 2.8,
the Prerequisites Wizard will install it for you. To update the MDAC
on remote servers, run the file MDAC_typ.exe located in the
\Prereqgst folder on the root of the RightFax Prerequisites CD.

Microsoft .Net Framework 1.1 is also required by all RightFax
servers and remote BoardServer computers. The Prerequisites
Wizard will scan your fax server and will install .Net Framework 1.1
if required. Those environments choosing to install SQL Server
2005 Express will be prompted to install .Net Framework 2.0. This
is again accomplished during the Prerequisites Wizard scan. To
update or install .Net Framework on remote servers, run the file
dotnetfx.exe located in the \Preregst folder on the root of the
RightFax Prerequisites CD.

Supported Versions of Microsoft SQL Server

RightFax uses a SQL database to store all data on faxes, users,
and dialing rules. During installation, you have the option to
connect to an existing SQL database on your network, or can use
the RightFax Prerequisite wizard to install and use a SQL Server
2005 Express database directly on the RightFax server. If you

N
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choose to connect to a SQL server already configured on your

network, RightFax supports only the following versions of Microsoft

SQL server:

¢ Microsoft SQL 2000 Standard Edition

 Microsoft SQL 2000 Enterprise Edition (standalone server)

o Microsoft SQL 2000 Enterprise Edition (in a SQL clustering
environment)

o Microsoft SQL Server 2005 Express

¢ Microsoft SQL 2005 Standard Edition
 Microsoft SQL 2005 Enterprise Edition (standalone server)

o Microsoft SQL 2005 Enterprise Edition (in a SQL clustering
environment)

Note MSDE 2000 is not supported.

Support for international character sets
in the RightFax database

@

Tip Many of the RightfFax client applications have localized versions that
allow non-English speakers to easily use the RightFax client tools. See
page 37for a complete list of the languages available in the RightFax
client applications. The languages into which the RightFax client
applications are translated are not related to the character sets that can
be stored in the RightFax database as discussed in this section.

RightFax supports a wide range of characters and symbols from
non-English alphabets. However, the RightFax server, SQL
database, and client applications must all be configured to use the
same symbol sets. If not, characters may not appear on your
clients’ outbound faxes as expected. This is because a character
written on a client computer that is using one symbol set may map
to an entirely different character when sent to a server using a
different symbol set.
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The symbol sets that are supported on the RightFax server and
client computers are determined by the Regional and Language
Options configured from Windows Control Panel and can be
changed at any time. The symbol set used by the SQL database,
however, is encoded into the database when it is installed based
on the current Regional setting on the SQL server. This is true
whether you have a separate SQL server or are installing the SQL
server during the RightFax installation. You should ensure that the
Regional setting on the SQL server is properly configured for the
character set that the server will support before installing the
database. If you have already installed a SQL database with the
incorrect Regional setting, contact Microsoft for assistance in
reconfiguring the SQL regional setting.

N

The following code pages are supported by the RightFax server
and client applications:

e 1250 (Albania, Croatia, Faeroese, Hungarian, Polish, Romanian,
Serbian, Slovak, and Slovenian)

« 1251 (Byelorussian, Bulgarian, Russian, and Ukrainian)

¢ 1252 (Afrikaans, Basque, Catalan, Danish, Dutch (Standard and

Belgium), English (US, Britain, Canada, New Zealand, Australian,

Ireland, S.Africa), Finnish, French (Standard, Belgium,

Switzerland, Canada, Luxem.), German (Standard, Swiss,

Austrian, Luxem., Liechtenstein), Icelandic, Indonesian, ltalian

(Standard, Swiss), Norwegian (Bokmal, Nynorsk), Portuguese

(Standard, Brazil), Spanish (Mexico, Traditional, Modern), and

Swedish)

1253 (Greek)

1254 (Turkish)

1255 (Hebrew)

(
(
1256 (Arabic)
(
(

e 1257 (Estonian, Latvian, and Lithuanian)
e 1258 (Vietnam)

Note Time strips are printed using the printer’s available symbol set
regardless of the code page in use on the server. For characters on these
lines to appear as expected, the code page on the fax server must match
the printer’s available symbol set. Because TTl lines and quick headers
are placed onto the fax image by your fax board, RightFax does not
support the use of diacritical characters on these lines.

Double-byte character support

Although the RightFax database does not store double-byte
characters, these characters are supported by server-side
application native document conversion. When you install and
configure the appropriate language support options to Microsoft
Word, Excel, and PowerPoint, RightFax will successfully convert

Chapter 1 Hardware and Software Requirements

11



N

double-byte documents to fax images. For more information on
server-side application conversion, refer to the RightFax
Administrator’s Guide.

Note Although double-byte characters added to the text of a Microsoft
Word cover sheet will convert correctly, double-byte characters inserted
into DocVariable fields on Microsoft Word cover sheets will not.

Fax Board Requirements

RightFax supports Brooktrout fax boards, Intel Dialogic (also known
as Gammalink) fax boards, and Eicon fax boards. For a list of all

supported fax board types, refer to the RightFax Fax Board Guide.

Installing the fax boards

Fax boards can be installed in the computer running the RightFax
server software, or on a separate computer called a Remote
BoardServer. For information on using Remote BoardServer
computers, refer to the RightFax Administrator's Guide.

Phone Line Requirements

The fax boards that RightFax supports can make use of several
different types of phone lines: loop-start (regular analog phone
lines), Direct Inward Dial (DID), Dialed Number Identification
Service (DNIS), Integrated Services Digital Network (ISDN), and
several types of digital phone lines. Different types of fax boards
support different types of phone lines. For information on the types
of fax boards that are compatible with your available phone lines,
refer to your fax board supplier or manufacturer.
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Loop-start phone lines

Loop-start lines can be used for incoming or outgoing faxes. A line
can be installed by the local telephone company if one is not
already available through your organization’s existing phone
system. Loop-start lines are also called POTS (Plain Old Telephone
Service) lines.

Direct Inward Dial (DID) phone lines

>

Each DID phone line is called a “trunk” When a DID trunk is
installed, it is assigned a bank of numbers. For example, a DID
trunk may be assigned the bank of 20 numbers ranging from
321-7450 to 321-7469. All calls to any of the assigned numbers
are routed to the DID trunk.

DID phone lines have a few special attributes. First, DID lines are
used for incoming faxes only. Outgoing faxes must be sent through
a standard loop-start line. Second, the customer, rather than the
phone company, supplies the power (called the “talk battery”)
necessary to drive the phone line. For this reason, DID fax boards
come with an additional power adapter which provides the
necessary —48 volt current.

DID allows RightFax to route incoming faxes to their intended
destinations within your company. Whenever someone dials a
number within the range, the DID trunk is activated by the phone
company and the fax board accepts the incoming fax. Along with
the fax data, the phone company sends the board the last three or
four digits of the phone number dialed. The fax board collects these
digits and passes them to RightFax. Each RightFax user has a
personal fax mailbox which is assigned one of the DID trunk’s
numbers (known as the “routing code”). Received faxes are routed
to the mailbox whose routing code matches the dialed DID number.

Warning Never plug a loop-start phone line into a DID fax board when
there is any voltage present on the phone line. Doing so will damage the
fax board and void all warranties.

12



Dialed Number Identification Service (DNIS) phone lines
DNIS is a T1-based version of DID service. For information on
configuring your fax boards for DNIS, refer to the hardware guide
included with your fax board.

Integrated Services Digital Network (ISDN) phone lines

ISDN is a worldwide standard communications network for digital
data, voice, and video communication. The main advantages of
ISDN over analog telephone lines are fast call setup and release
and additional cost-recovery information included with the call.

PRI, BRI, E1, and T1 digital phone lines

RightFax supports PRI, BRI, E1, and T1 digital phone lines
assuming you have purchased and installed the appropriate type of
fax boards and network interface card. For more information on
digital phone lines, refer to the RightFax Fax Board Guide.

Chapter 1 Hardware and Software Requirements 13
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Chapter 2
What Is Installed on the RightFax Server?

The RightFax server installation program installs the complete suite

RightFax Software

of RightFax products. The capabilities of the server and the
modules that are enabled depend on your product licensing.
Because all of the RightFax software is installed, the RightFax
server can be upgraded and optional modules can be added simply
by purchasing a license and activating the feature. For information
about upgrading the server and adding new RightFax modules, see
Chapter 7, “Upgrading and Adding Fax Channels, User Licenses,
and Optional Components”.

In addition to the installed software, The RightFax installation
creates several Windows services, adds RightFax configuration
settings to the Windows Registry, adds configuration programs to
Windows Control Panel, and installs the FaxUtil and Enterprise Fax
Manager client programs.

RightFax uses a SQL database to store all data on faxes, users,
and dialing rules. If you do not connect to an existing SQL
database on your network during installation, RightFax will install
and use a SQL Server 2005 Express database on the RightFax
server computer. This is a fully functional SQL database, but lacks
the SAOL management tools that accompany the full version of
Microsoft SQL server.

All of the RightFax software is installed on the server in the folder
you specify during installation. By default, the software installs in
the C:\Program Files\RightFax folder. Third-party software that is
used by the RightFax server, such as fax board drivers, may be
installed in other locations.

RightFax Configuration Programs

The RightFax server includes several configuration programs that
let you customize the RightFax services. The RightFax configuration
programs can be run from Windows Control Panel or from
Enterprise Fax Manager (described in the RightFax Administrator’s
Guide).

Chapter 2 What Is Installed on the RightFax Server?
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The following table describes all of the RightFax configuration
programs that are available.

Note Some of these configuration programs may not be enabled on the
server, depending on the type of RightFax server you have licensed and
the modules that are enabled.

Table 2a RightFax Server Configuration Programs

RightFax 9.3 Feature Pack 1 Installation Guide

Table 2a RightFax Server Configuration Programs (Continued)

Configuration
program Description

Configuration
program

Description

Captaris Conversion
Engine

The Captaris Conversion Engine is a stand-alone,
fault tolerant service that is used to invoke
applications commonly used in server-side
application conversion. These applications will be
used to convert their associated file types when
installed on the RightFax server and remote
WorkServers.

Captaris Sync

The Captaris Sync Module is an XML/XSLT based
tool that allows RightFax administrators to create
and synchronize users from Active Directory
domains, groups, and organizational units. LDAP
compliant data sources are also supported.

RightFax BoardServer | This is a configuration program used for legacy
Brooktrout fax boards supported by RightFax. Use
the BoardServer configuration program to
customize each installed fax board and each fax
channel. Although you may have only one
BoardServer service installed on a single computer,
you can optionally create RightFax BoardServer
services on remote computers to offload fax board
processes or to expand your network'’s fax board
and fax channel capacity. For more information on
BoardServers, refer to the RightFax Administrator’s
Guide.

The BoardServer configuration program can only be
launched from within the Doc Transport program
(described next.)

For more information on the fax boards you use and
their configuration requirements, refer to the

RightFax Alerting

Use this program to configure the RightFax Alerting
and Monitoring feature. This feature lets RightFax
administrators create custom server statistics to
monitor and define thresholds on which to send
alerts. For more information on the Alerting and
Monitoring feature, refer to the RightFax
Administrator’'s Guide.

RightFax Fax Board Guide.
RightFax Doc The Doc Transport configuration program is used to
Transport configure most transport methods for your RightFax

documents including standard fax boards, T.37
Fax-over-IP, SMS (short message service) and fax
board simulation .

All fax board configuration, including BoardServer
configuration, is initiated from this configuration
program.

For more information on the fax boards you use and
their configuration requirements, and the T.37 and
T.38 Fax-over-IP features, refer to the RightFax Fax
Board Guide. For information on document
transport via SMS, refer to the RightFax
Administrator’s Guide.
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Table 2a RightFax Server Configuration Programs (Continued)

Configuration

program Description
RightFax E-mail Use this program to create and modify the RightFax
Gateway e-mail gateway services. E-mail gateway services

act as the communication link between the RightFax
server and your organization's e-mail software. It is
possible to install multiple e-mail gateways, each
communicating with a different e-mail server. For
more information on e-mail gateways, refer to the
RightFax Administrator’s Guide, the RightFax
Gateway for Microsoft Exchange Guide, or the
RightFax Gateway for Lotus Notes Guide
(depending on the gateway you add).

RightFax Integration

Use this program to modify the RightFax Integration
Module service. The Integration Module integrates
the RightFax server with applications on mainframe,
mid-range, and local area network host systems. For
more information on the RightFax Integration
Module, refer to the RightFax Integration Module
Guide.

RightFax SAP
Connector

Use this program to create and modify the RightFax
SAP gateway services. SAP gateway services act
as the communication link between the RightFax
server and SAP clients. It is possible to install
multiple SAP gateways, each communicating with a
different SAP client. For more information on the
SAP gateway module, refer to the RightFax
Connector for SAP R/3 Guide.

Table 2a RightFax Server Configuration Programs (Continued)

Configuration
program

Description

RightFax Server

Use this program to modify the RightFax Server
service. The Server service controls all of the
RightFax services and coordinates communication
between the server computer, client computers, fax
boards, and the fax database. For more information
on the RightFax Server service, refer to the RightFax
Administrator's Guide.

RightFax WorkServer

Use this program to create and modify the RightFax
WorkServer services. WorkServer services perform
the most processor-intensive functions required by
the RightFax server, such as cover sheet generation,
PCL-to-fax conversion, and optical character
recognition. By default, three separate WorkServer
services are installed on the RightFax server, and
each WorkServer service can be customized to
perform specific functions. You can also create
RightFax WorkServer services on remote computers
to offload your most processor-intensive functions.
For more information on WorkServers, refer to the
RightFax Administrator’s Guide.

Chapter 2 What Is Installed on the RightFax Server?
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RightFax Services

The names of all RightFax services begin with the word “RightFax”
or “Captaris.” This lets you easily identify all of RightFax services
that are currently running. You can modify most RightFax services
through their configuration programs, which can be run from
Windows Control Panel or from the RightFax administrative
program, Enterprise Fax Manager (described in the RightFax
Administrator's Guide).

RightFax Registry Entries

All of the RightFax registry entries are located in the Windows
Registry under the following keys:

e HKEY_CURRENT_USER\SOFTWARE\RightFax

e HKEY_CURRENT_USER\SOFTWARE\RightFax Client
e HKEY_LOCAL_MACHINEASOFTWARE\RightFax

e HKEY_LOCAL_MACHINE\SOFTWARE\RightFax Client
e HKEY_CLASSES_ROOT\RF...

e« HKEY_CLASSES_ROOT\RightFax...

In most cases, you should not have to make changes or additions
to the RightFax registry settings. However, some RightFax features
do require you to make modifications to the Windows Registry.
Wherever this is true, instructions are provided in the RightFax
documentation.

RightFax 9.3 Feature Pack 1 Installation Guide

RightFax Client Applications

In addition to the RightFax server software, several RightFax client
applications are available that allow administration of the fax
servers (Enterprise Fax Manager), user access to fax mailboxes
(FaxUtil), print drivers that allow users to print documents directly
to fax format for delivery to the RightFax server (RightFax print
drivers), and Web-based versions of these applications. For more
information FaxUtil, Enterprise Fax Manager, the RightFax print
drivers, and the Web-based equivalent applications, refer to the
RightFax Administrator's Guide.
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Chapter 3
Installing the RightFax Server Software

e In RightFax version 9.3, the proprietary database used in pre 9.0
versions has been changed to a Microsoft SQL database. During
an upgrade, all existing RightFax database objects will be

Upgrading from a Previous Version of RightFax
¢ You can only upgrade to RightFax version 9.3 from RightFax

versions 8.7 SP3 or 9.0 SP2. If you are running an earlier version
of RightFax, you must either upgrade your earlier version to
version 8.7 SP3 or 9.0 SP2, or uninstall the RightFax server and
perform a new installation of RightFax 9.3.

¢ The RightFax database must be named ‘RightFax. If you have
renamed your RightFax database, it's default name must be
restored before continuing. After completing the upgrade you
may rename the database to a name of your choosing. See
Microsoft documentation for information outlining how to rename
a SQL database.

Support for some fax boards has been discontinued with this
release. For a complete list of fax boards supported by this
version, refer to the RightFax Fax Board Guide. If you have
already installed one or more fax boards that do not appear on
this list, do not upgrade to this version of RightFax.

converted to SQL with no loss of data. The RightFax installation
allows you to install SQL Server 2005 Express directly on the
RightFax server, or you can connect to an existing SQL database
on your network. Note that the version of SQL provided with
RightFax has limited administrative functionality and includes no
database backup or maintenance tools. If you do not connect to
an existing full copy of Microsoft SQL database during
installation, you will probably need to acquire a suite of SQL
backup and maintenance tools separately.

Before upgrading from an 8.7 SP3 version of RightFax, Captaris
recommends that you check the RightFax database for errors.
Run the DBCheck.exe program, and clean up the database if
needed. For instructions on DBCheck.exe, refer to the 8.7
version of the RightFax Administrator's Guide.

All 9.0 SP2 installations that have implemented a local MSDE
database must upgrade MSDE to SQL Server 2000, SQL
Server 2005 or SQL Server 2005 Express. SQL Server 2005
Express is shipped with RightFax 9.3. The option to upgrade
MSDE to SQL Server 2005 Express is presented during the 9.3
installation. Remote MSDE installations cannot be upgraded via
the RightFax installation and must be done so from the local
MSDE computer.

Chapter 3 Installing the RightFax Server Software
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¢ Before upgrading, back up the entire Program Files\RightFax
folder structure. To get a complete backup of your RightFax
server software, you must first stop all RightFax services.

o Before upgrading an earlier version of the RightFax remote
BoardServer software, you must uninstall the existing remote
BoardServer software. To uninstall RightFax remote BoardServer
software, run the uninstall program from the Add/Remove
Programs application in Windows Control Panel. You must then
perform a new install of both the RightFax server software and fax
board drivers.

o Before upgrading an earlier version of a Dialogic series fax driver,
you must remove the existing drivers. To uninstall the drivers, run
the uninstall program from the Add/Remove Programs
application in Windows Control Panel. You must then perform a
new install of the fax board drivers.

e During the MSDE to SQL Server 2005 Express upgrade, the
MSDB database is not upgraded. Consequently, you may see
error messages when attempting to run OSQL backup and
restore procedures. These errors are cosmetic and do not cause
any loss in functionality. For more information, see Microsoft
Knowledge base article 907284,

e The RightFax Web Client shipped will RightFax versions prior to
9.0 has been replaced with a completely new Web client called
RightFax Web Access. If you will be installing RightFax Web
Access on the same IS server on which an earlier version of the
RightFax Web client was installed, you must first uninstall the
existing RightFax Web Client software. Any custom pages
designed for your old Web client application will be lost.

¢ Any existing files for the RightFax SecureDocs Module or
Enterprise Fax Manager Web Edition will be deleted when you
upgrade these applications on the Microsoft IIS server. If you
have created customized files for any of these applications, you
must save copies of the customized files before upgrading, and
then merge your customizations into the upgraded files.

RightFax 9.3 Feature Pack 1 Installation Guide

e After upgrading a Windows 2003 server from a RightFax version
prior to version 9.3, you may receive error messages on restart
reporting that one or more RightFax services have shut down
improperly. This is a result of the earlier-version services being
shut down during installation. These messages can be closed
and disregarded.

By the time you receive this software, new information or software
updates may be available. For the latest information on RightFax
software, visit the RightFax support Web site at
www.captaris.com/support/downloads/rightfax/index.html. This
Web site may provide up-to-date information on installing and
upgrading the RightFax server

Overview

Upgrading your RightFax server to version 9.3 software is a three
step process, each of which requires its own separate CD.

1. Determine which third-party components are required and if
necessary install them running using the Prerequisites Wizard
described on page 21.

2. Install the core fax server software described on page 23.

3. Install the fax board software and drivers described on page 23.

Rolling out a software upgrade

If you have a large enterprise with a complex server and client
system, you may want to gradually phase in the RightFax software
upgrade.

Because the RightFax server software is backward-compatible with
all supported versions of the RightFax client software, you should
plan to upgrade the server first, and then upgrade the client
systems later.
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The RightFax servers need not all be upgraded at the same time.
You can run a network of RightFax servers of different versions
without loss of functionality. The same is true for RightFax client
applications.

To automate the installation of the server on a network with a
network management system such as SMS, see “Running a silent
install of the RightFax server software” on page 36.

To install the RightFax client applications, refer to the RightFax
Administrator's Guide.

Upgrading the RightFax Server

When upgrading a RightFax server, you must upgrade both the
server software and the hardware drivers. First upgrade the server,
then upgrade the hardware drivers.

The RightFax server upgrade copies your existing RightFax
database to an existing SQL server or lets you install a SQL Server
2005 Express database directly on the RightFax server. SQL
Server 2005 Express does not include any SQL management tools
such as database backup utilities. If you intend to install SQL
Server 2005 Express, which is provided with RightFax, Captaris
recommends that you purchase a separate SQL backup utility and
any additional SQL management tools you feel necessary for
proper management of your RightFax database.

When installing SQL Server 2005 Express on a computer that is
running Windows 2000 or 2003 Server, the Microsoft Data
Access Components (MDAC) are automatically updated to MDAC
2.8, the Windows Installer is updated to version 3.0, and .Net
Framework 2.0 is installed. Each of these is a requirement of SQL
Server 2005 Express.

Warning If you will be installing the RightFax database to an existing
Q SQL server, the SQL server must be configured to use SQL mixed-mode
authentication. If the SQL server is set to use Windows authentication,
the database will not install properly. If your SQL server is configured to
use Windows authentication, you must set it to use mixed-mode
authentication before installing RightFax. After the installation is

complete, you can re-set the SQL server for Windows authentication. For
instructions on configuring RightFax to use Windows authentication with
SQL server, refer to the RightFax Administrator's guide.

Running the Prerequisites Wizard

The Prerequisites Wizard will scan your server for third-party
software that is required for the installation of the following
components:

o RightFax Server: The core RightFax server software.

e RightFax Client: Enterprise Fax Manager, FaxUtil, RightFax print
drivers, and the MMC Administrative Tool for the RightFax
Connector for Exchange.

« Remote Services: Remote BoardServer and other server
components installed remotely to share resources across
machines.

« 1IS Web Applications: Certified Delivery, RightFax Web Access,
and other Web-based RightFax applications.

e Exchange Connector: The RightFax Connector for Exchange.

Each of these components has their own set of requirements. The
Prerequisites Wizard will determine the status of these
requirements and will provide the option of installing them if
necessary, or as in the case of Windows service packs, Exchange
and IIS, will inform you if their requirement and the need to acquire
and install them separately.

Other requirements, such as .Net Framework, Windows Installer
version 3.0, and MDAC 2.8 are provided on the Prerequisites CD
and are thus installed by the Prerequisites Wizard. Windows
Message Queueing (if required) will also be installed via the

Chapter 3 Installing the RightFax Server Software
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Prerequisites Wizard, however, this is accomplished by utilizing the
Add/Remove Windows Components Wizard located in the
Windows > Add/Remove Programs Control Panel.

Warning If Windows Message Queueing is required and you are
upgrading MSDE to SQL Server 2005 Express, the install of Windows
Message Queueing will stop all MSDE services.

Important The Prerequisite Wizard cannot upgrade remote MSDE
installations to SQL Server 2005 Express. This upgrade must be done
from the MSDE server and prior to installing RightFax. To install SQL
Server 2005 Express, run the file SQLEXPR.exe located in the \Preregst
folder on the root of the RightFax Prerequisites CD. More information
about installing SQL Server 2005 Express can be found at
http://support.microsoft.com.

Caution The installation of RightFax 9.3 cannot be stopped or reverted
for any reason.

1. Log on to the computer using an ID with NT administrative
access. If you do not log on with administrative access, the
upgrade will fail.

2. Insert the RightFax Prerequisites CD. If AutoRun is enabled, a
menu of install options appears. If AutoRun is not enabled,
browse the CD and run Setup.exe. The RightFax Prerequisites
wizard opens.

3. Click Next at the Prerequisites Wizard opening screen.

4. On the Select RightFax Components screen, select the
components you wish to install or upgrade. At a minimum these
should include the options of RightFax Server and RightFax
Client. Click Next after making your selections.

5. The Prerequisites Preview screen lists third-party software that
is required by those components previously selected. Software
that must be installed will have a status of Not Installed. The
SQL Server status should have a status of Info Required. Click
Next to either install required software, or to enter your SOL
Server information. Should you need to install additional
software, you may need to re-run the Prerequisites Wizard.

RightFax 9.3 Feature Pack 1 Installation Guide

6. On the SQL Server screen, select the type of SQL database
you want use for RightFax:

o | will specify connection information for an existing SQL
server. Select this option if you have a SQL server already
running on your network and want to install the RightFax
database schema directly to that server.

Click Next if you connect to an existing SQL database, a screen
will open prompting you for connection and login information
that will allow the RightFax server to access the SQL database.
Complete the options on this dialog box according to your
existing SQL installation and then click Next.

¢ Install Microsoft SQL Server 2005 Express Database
Edition. Select this option if you do not have or do not have
access to an existing SQL 2000 or 2005 Server on your
network. RightFax will install a stripped-down version of SQL
sever.

Click Next to verify SQL Server 2005 Express requirements. If
necessary you will be prompted to install MDAC 2.8, Windows
Installer 3.0, and .Net Framework 2.0. Upon completing the
installation of these components, you will be prompted with the
SQL Server 2005 Express installation. These installations can
take several minutes.

On the SQL Server Information screen, document the SQL
Server, User ID, and Password. These items are critical and
should be documented safely and securely.

If your existing SQL server is using a port number other than the
default of 1433, you must specify the correct port number
during the RightFax Prerequisite Wizard. When prompted for
your SQL Server name, enter the SQL Server name followed by
a comma and the port number.

For example:
SQLServer,55123

If a SQL instance name is being used:
SQLServer\Mylnstance,55123
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7.

When the software update is complete, click Finish.

Running the RightFax server upgrade

1.

Insert the RightFax server CD. If AutoRun is enabled, a menu of
install options appears. If AutoRun is not enabled, browse the
CD and run Setup.exe. The RightFax install wizard opens.

Click Next at the opening screen to view the RightFax license
agreement. You must accept the license agreement in order to
continue the installation. Click Next.

On the Advanced Options screen, you will be prompted to
enter configuration information based on your previous RightFax
installation and the components you selected during the
Prerequisites Wizard. It is recommended that you do not
change these settings however, if this cannot be avoided you
must first re-run the Prerequisites Wizard followed by the
RightFax server setup. Click Next.

When the software update is complete, click Finish.

If you have upgraded from 8.7 SP3 and have the RightFax
SecureDocs Module installed and running, you must complete
an additional step to make sure that your existing RightFax

database is properly synchronized with the new SQL database.

5. Open a command line prompt.

Change to the RightFax\WebApps\SecureDocs\Apps folder.

7. Run the following command:
synchdb RFServer 4 RightFax SQLLogin/D Password

Where RFServer is the name of the RightFax server being
upgraded. SQLLogin/D is the login ID used to access the SQL
database. This will be the DSN login ID if you are connecting to
an existing SQL server or “sa” if you installed the MSDE SQL
database. Password is the password for the SQL login you
specified. If you installed the MSDE database, the password is
blank which is indicated by two double quotes.

Examples synchdb RFServ 4 RightFax JaneDoe MyPassword
synchdb RFServ 4 RightFax sa “*

8. If the command executed properly, a success message will
display.

9. Finally, all existing SecureDocs recipients will be prompted to
recreate their login information when accessing SecureDocs
documents on the SecureDocs Web site.

Important If you are upgrading an 8.7 server using foreign code pages,
you must select the option of ANSI Mode in the RightFax Server module,
Advanced tab.

Upgrading the RightFax fax board drivers

1. After the RightFax server has been upgraded, remain logged on
to the computer using an ID with NT administrative access.

2. Insert the RightFax hardware drivers CD. If AutoRun is enabled,
a menu of install options appears. If AutoRun is not enabled,
browse the CD and run Setup.exe. The RightFax install wizard
opens.

3. Click Next at the opening screen to view the RightFax license
agreement. You must accept the license agreement in order to
continue the installation. Click Next.

Chapter 3 Installing the RightFax Server Software
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4. On the Fax Hardware Selection screen, select the type of fax
boards you have installed (Brooktrout and/or Dialogic). Click
Next.

5. Click Install to begin the installation.

6. When the Transport Configuration screen opens, click OK to
keep your existing fax hardware configuration.

7. When all of the updated drivers have been installed, click Finish
to complete the RightFax Fax Board Driver install wizard.

Installation Overview

R

Important If you are installing RightFax in a Windows 2000 or 2003
cluster, refer to “Clustering RightFax with Microsoft Windows 2003
Server” on page 61 for special instructions.

The RightFax server is the computer that runs the fax server
software. The server performs all the work required for sending and
receiving faxes, including managing the fax database, converting
documents into fax images, adding signatures, overlaying forms,
maintaining logs, printing faxes, and creating fax cover sheets.

The RightFax server installation lets you create a new RightFax
database on an existing SQL server or install an SQL Server 2005
Express database directly on the RightFax server. SQL Server
2005 Express does not include any SQL management tools such
as database backup utilities. If you intend to install SQL Server
2005 Express, provided with RightFax, Captaris recommends that
you purchase a separate SQL backup utility and any additional
SQL management tools you feel necessary for proper management
of your RightFax database.

When installing SQL Server 2005 Express on a computer that is
running Windows 2000 Server, the Microsoft Data Access
Components (MDAC) are automatically updated to MDAC 2.8,
unless a newer version already exists on the server.

RightFax 9.3 Feature Pack 1 Installation Guide

A complete RightFax server installation is comprised of these major
tasks:

1. Optionally install the fax boards into your RightFax server
chassis. If you will be using one or more remote BoardServer
computers to house the fax boards, you do not need to have fax
boards installed in the RightFax server computer. For more
information on using remote BoardServer computers, refer to
the RightFax Administrator's Guide.

Note This step does not include installing the fax board driver
software. The fax board drivers should be installed only after installing
the RightFax server software.

2. Run the Prerequisites Wizard (see “Running the Prerequisites
Wizard” on page 21).

3. Install the RightFax server software (see “To ensure that your
RightFax server installation goes smoothly and to avoid
unnecessary delays, it is important to perform each step in the
installation completely and correctly before proceeding to the
next step” on page 26).

4. Enable your licensed product feature set (see “Enabling Your
Licensed Product Feature Set” on page 28).

5. Install the fax board drivers (see “Installing the Fax Board
Drivers” on page 28).

6. Configure the RightFax Server, WorkServer, and DocTransport
modules (described in the RightFax Administrator's Guide).

7. Test the fax boards (described in the RightFax Fax Board
Guide).

8. Set up users and other RightFax database objects using
Enterprise Fax Manager (described in the RightFax
Administrator's Guide).

By the time you receive this software, new information or software
updates may be available. For the latest information on installing
RightFax servers, visit the RightFax support Web site at
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www.captaris.com/customer_support. This site may provide
up-to-date information on installing and upgrading your RightFax
server.

Warning If you will be installing the RightFax database to an existing
SQL server, the SQL server must be configured to use SQL mixed-mode
authentication. If the SQL server is set to use Windows authentication,
the database will not install properly. If your SQL server is configured to
use Windows authentication, you must set it to use mixed-mode
authentication before installing RightFax. After the installation is
complete, you can re-set the SQL server for Windows authentication. For
instructions on configuring RightFax to use Windows authentication with
SQL server, refer to the RightFax Administrator’s guide.

Supported Database Collation

The RightFax 9.3 database supports only the SQL Language
collation. Case sensitivity, Accent sensitivity and Kana
sensitivity collations are not supported.

Running the Prerequisites Wizard

The Prerequisites Wizard will scan your server for third-party
software that is required for the installation of the following
components:

o RightFax Server: The core RightFax server software.

o RightFax Client: Enterprise Fax Manager, FaxUtil, RightFax print
drivers, and the MMC Administrative Tool for the RightFax
Connector for Exchange.

o Remote Services: Remote BoardServer and other server
components installed remotely to share resources across
machines.

o 1IS Web Applications: Certified Delivery, RightFax Web Access,
and other Web-based RightFax applications.

¢ Exchange Connector: The RightFax Connector for Exchange.

> P

Each of these components has their own set of requirements. The
Prerequisites Wizard will determine the status of these
requirements and will provide the option of installing them if
necessary, or as in the case of Windows service packs, Exchange,
Internet Explorer 6.01 and IS, will inform you if their requirement
and the need to acquire and install them separately.

Other requirements, such as .Net Framework, Windows Installer
version 3.0, and MDAC 2.8 are provided on the Prerequisites CD
and are thus installed by the Prerequisites Wizard. Windows
Message Queueing (if required) will also be installed via the
Prerequisites Wizard, however, this is accomplished by utilizing the
Add/Remove Windows Components Wizard located in the
Windows > Add/Remove Programs Control Panel.

Warning If Windows Message Queueing is required and you are
upgrading MSDE to SQL Server 2005 Express, the installation of
Windows Message Queueing will stop all MSDE services.

Caution The installation of RightFax 9.3 cannot be stopped or reverted
for any reason.

To ensure that your RightFax server installation goes smoothly and
to avoid unnecessary delays, it is important to perform each step in
the installation completely and correctly before proceeding to the
next step.

1. Log on to the computer using an ID with NT administrative
access. If you do not log on with administrative access, the
upgrade will fail.

2. Insert the RightFax Prerequisites CD. If AutoRun is enabled, a
menu of install options appears. If AutoRun is not enabled,
browse the CD and run Setup.exe. The RightFax Prerequisites
wizard opens.

3. Click Next at the Prerequisites Wizard opening screen.

Chapter 3 Installing the RightFax Server Software
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4. On the Select RightFax Components screen, select the

components you wish to install. At a minimum these should
include the options of RightFax Server and RightFax Client.
Click Next after making your selections.

. The Prerequisites Preview screen lists third-party software that
is required by those components previously selected. Software
that must be installed will have a status of Not Installed. The
SQL Server status should have a status of Info Required. Click
Next to either install required software, or to enter your SQL
Server information. Should you need to install additional
software, you may need to re-run the Prerequisites Wizard.

. On the SQL Server screen, select the type of SQL database
you want use for RightFax:

Caution After it is installed, the RightFax SQL database is
permanently associated with the name of the RightFax server you are
installing. If for any reason you need to replace or rebuild this
RightFax server, the new server must have the exact same network
identification as the original.

o | will specify connection information for an existing SOL
server. Select this option if you have a SQL server already
running on your network and want to install the RightFax
database schema directly to that server.

Click Next if you connect to an existing SQL database, a screen
will open prompting you for connection and login information so
the RightFax server can access the SQL database. Complete
the options on this dialog box according to your existing SQL
installation and then click Next.

¢ Install Microsoft SOL Server 2005 Express Database
Edition. Select this option if you do not have or do not have
access to an existing SQL 2000 or 2005 Server on your
network. RightFax will install a stripped-down version of SQL
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sever.

Click Next to verify SQL Server 2005 Express requirements. If
necessary you will be prompted to install MDAC 2.8, Windows
Installer 3.0, and .Net Framework 2.0. Upon completing the
installation of these components, you will be prompted with the
SQL Server 2005 Express installation. These installations can
take several minutes.

On the SQL Server Information screen, document the SQL
Server, User ID, and Password. These items are critical and
should be documented safely and securely.

If your existing SQL server is using a port number other than the
default of 1433, you must specify the correct port number
during the RightFax Prerequisite Wizard. When prompted for
your SQL Server name, enter the SQL Server name followed by
a comma and the port number.

For example:

SQLServer,55123

If a SQL instance name is being used:

SQLServer\Mylnstance, 55123

7. When the software update is complete, click Finish.

To install the RightFax server software

1.

Log on to the computer using an ID with NT administrative
access. If you do not log on with administrative access, the
installation and configuration of RightFax will fail.

Notelf you are installing on a Novell network, the SAP Agent,
NWLINK IPX/SPX, and Gateway for NetWare must be installed on
your RightFax server. File and Print services for NetWare should be
installed if you plan to connect DOS clients.

Insert the RightFax server CD. If AutoRun is enabled, a menu of
install options appears. If AutoRun is not enabled, browse the
CD and run Setup.exe. The RightFax install wizard opens.
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. Click Next at the opening screen to view the RightFax license
agreement. You must accept the license agreement in order to
continue the installation. Click Next.

. Enter your name, organization name, and your product serial
number when prompted. Click Next.

. On the Setup Type screen, select Typical Server to install the
RightFax server components, the Enterprise Fax Manager server
management tool, and FaxUtil, the RightFax fax mailbox. If you
want to install additional server and client components, select
Custom. Click Next.

. The components you selected during the Prerequisites Wizard
are reflected in the server components listed on Setup
Features screen. It is recommended that you do add any
additional server settings however, if this cannot be avoided you
must first re-run the Prerequisites Wizard followed by the
RightFax server setup. Some of these additional components
require separate licensing, and may need additional
configuration after the server is installed. For information on
which components you have licensed, refer to the software
product license card that was included with your RightFax
software package. When you have selected the components to
install, click Next.

. On the Advanced Options screen, you will be prompted to
enter additional configuration information for the RightFax
installation. Disabled options are not required for the feature set
you selected.

SMTP Host. Enter the name of the SMTP server on your
network that will transport all SMTP alerts and notifications and
fax-over-IP messages. If you will not be using SMTP to deliver
RightFax alerts or send documents via fax-over-IP, you may
leave this option blank.

IIS User Account. If you have selected to install server
components that require 1S server, enter the IIS user account
that RightFax will use to access the IIS server.

AY

RightFax Server Name. This option will only be available when
installing clients, services, and gateways on remote computers.
This tells the remote software where to locate the RightFax
server.

Certified Delivery Webserver. If you are installing the Certified
Delivery feature of the RightFax SecureDocs Module, enter the
name of the IIS server on which the Certified delivery Web site
will be located. Click Next.

. Click Install to begin the installation.

9. When prompted, select the service account that the RightFax

services will use to start. This should be an account with
administrative privileges on the RightFax server. You can click
Load Users to list all the user accounts accessible to the server
computer and select the user account you want.

Note If you will be accessing files from or printing to Novell queues
on a NetWare volume, the service account must exist in Novell as an
account.

10.You will be prompted to add an e-mail gateway. E-mail gateways

let your organization’s fax users send and receive faxes through
their e-mail client applications. To add one or more e-mail
gateways, click Add Gateway and select the type of gateway to
add. When you add a new gateway, a configuration dialog box
opens. For information on completing the options in this dialog
box, refer to the RightFax Administrator’s Guide.

Chapter 3 Installing the RightFax Server Software
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11.0n new installations, the install wizard installs all of the selected
RightFax components, but does not fully enable the software.
The RightFax software must have its licensed feature set
enabled, which you can do either via the Web, or by contacting
the Captaris support department. For more information on
enabling the licensed feature set, see “Enabling Your Licensed
Product Feature Set” on page 28.

When the software installation is complete, click the Register
Online button to enable your licensed product feature set via
the Web. If you would prefer to contact the Captaris support

department to enable your licensed product feature set, click

Finish.

Enabling Your Licensed Product Feature Set

A

Notelf you are upgrading an existing RightFax server, your existing
feature set will be retained and this step is unnecessary.

After you complete a new installation of RightFax, the server will be
licensed only for a limited feature set. To enable the full licensed
functionality of your RightFax server, you must register the software
with Captaris. At that time, you will be issued a “bump” code that
enables your full feature set. Captaris provides two methods for
registering your RightFax software.

Registering via the Web

On the last screen of the RightFax installation wizard is a Register
Online button. You can click this button to register your RightFax
software online during installation. Follow the instructions provided
on the Web page to complete the registration and enable the full
feature set of your RightFax server.
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Registering through the Captaris support department

You can also register your RightFax server by contacting the
RightFax product support group at (520) 320-7070. The support
engineer will assist you through the registration process.

Installing the Fax Board Drivers

Regardless of the type of fax boards you use, you must run a
separate fax board hardware driver install program on all
computers containing the fax boards after installing the server. This
install program is provided with your RightFax server software on a
separate CD labeled “Fax Board Driver Install”

Follow these steps to install the fax board hardware drivers. Be
sure to run this installation on all RightFax servers and remote
BoardServer machines after installing or upgrading the RightFax
server.

To install the fax board drivers

1. Insert the Fax Board Driver Install CD. If AutoRun is not
enabled, run Setup.exe. The RightFax Hardware Module install
wizard opens.

2. Click Next at the opening screen to view the RightFax license
agreement. You must accept the license agreement in order to
continue the installation.

3. On the Fax Hardware Selection screen, select the type of fax
boards you have installed (Brooktrout and/or Dialogic). Click
Next.

4. Click Install to begin the installation.
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5. If you are installing a Brooktrout fax board, the DocTransport
Configuration dialog box will open after the driver files have
been installed. This configuration screen for the RightFax
DocTransport module which lets you configure the methods by
which RightFax will be able to transmit documents. This module
lets you configure fax boards for conventional fax transmission,
as well as set up RightFax for SMS messaging, Fax-over-IP,
DOCPIus, and some specific Intel and Eicon fax boards. For
information on properly completing the options in the
DocTransport module Transport Configuration dialog box,
refer to the RightFax Administrator’s Guide.

6. After you close the Transport Configuration dialog box, click
Finish to complete the RightFax Hardware Module install
wizard.

If you installed drivers for the Dialogic DM3 fax board series, a
separate Dialogic board configuration program must be run. For
information on completing this installation and subsequent
configuration, refer to the documentation included with your fax
board or contact your board manufacturer.

7. When prompted to restart the computer, select Yes.

Installing the RightFax Web Applications

RightFax includes these Web-based applications that can be
installed on servers running Microsoft IIS version 5.0 or higher:

e Enterprise Fax Manager Web Edition (also requires .NET
Framework 1.1 or greater)

« RightFax Web Access (also requires .NET Framework 1.1 or
greater)

¢ RightFax Certified Delivery
¢ RightFax SOAP Server

These IIS applications should not be installed on the same
computer as the RightFax server software, even if lIS is installed on
the RightFax server. Captaris recommends that all IIS applications
be installed on a dedicated IIS server, separate from the RightFax
server.

Tip Servers running Microsoft Windows 2003 do not have /1S installed
by default. On Windows 2003, IS 6.0 must be selected as an optional
component during the operating system installation

To install one or more of these applications, access the IIS server
on which the applications will be installed and run the server
installation (described on page 25). Select the applications to
install under the “IIS” heading in the Setup Features screen.

If you are installing any of these applications on a server running IS
version 6.0, you must change some of the default settings in the IIS
configuration. These changes can be made either before or after
you install the RightFax client applications, but they must be
completed before these applications will work on computers
running 11S 6.0:

e For Windows 2000 Server and Windows 2003 Server, you must
register ASP.NET as a Web Service Extension. To do this, click
Start > Run, then type emd. Enter the following at the command
prompt, and press ENTER:

C:\Windows\Microsoft. NET\Framework\v7."\aspnet_regiis -i

where v1.*is the most recent version of .NET Framework on your
server.

e In Internet Information Services Manager, Active Server Pages,
ASP.NET, and ISAPI Extensions must be enabled. These
features are enabled from the Web Service Extensions folder.

o Parent Paths must be enabled, either for the Default Web Site as
a whole, or for the SecureDocs virtual directory which appears
after the installation of Certified Delivery. Edit the properties of
either of these sites and select the Directory tab. Click
Configuration, open the Options tab, and select Enable Parent
Paths.

Chapter 3 Installing the RightFax Server Software
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Configuring SQL Server for RightFax Web Access

If you install SQL Server using Windows Authentication mode and
plan to use RightFax Web Access, then you must configure
specific RightFax services to run as a local Administrator, and then
edit a configuration file so that users are able to log in.

To configure RightFax services

1. Choose Start > Settings > Control Panel, then double-click
Administrative Tools.

2. Double-click Services.

3. Right-click RightFax DocTransport Module and choose
Properties.

4. Display the Log On tab, then select This account. Enter the
credentials of a user with local Administrator rights.

5. Click OK.
6. Repeat this procedure for these services:

¢ RightFax Database Module
¢ RightFax Server Module
¢ RightFax Remoting

7. Open Enterprise Fax Manager and highlight the fax server name.
8. In the Services pane, double click the Remoting Service.

9. In the Remoting Service “Database Connection” Field, type the
following string:

Integrated Security=SSPI;Persist Security Info=True;Data
Source=MySqlServer;initial catalog=RightFax

10.Click Apply followed by OK.
11.Double click the Database Module.
12.Click the ellipse button.

13.Choose the option Login with Windows NT Authentication
using the Network Login ID.
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14.Click OK until finished.
15.Repeat steps 7-14 for the DocTransport Service

16.Choose Start > Settings > Control Panel, then double-click
Administrative Tools.

17. Double click Data sources ODBC.

18.Choose System DSN.

19.Double click the RightFax database.

20.Verify the data source name and the SQL server. Click Next.

21.Under “How should SQL Server verify the authenticity of the
login ID?" Choose the option of “With Windows NT
authentication using the network login ID".

22.Click Next on each remaining screens, and then click Finish. To
test your settings, click the Test Data Source button.

23.Click OK to exit ODBC datasources.
24.Restart all RightFax services.

Accessing RightFax Web Access from a Browser

After RightFax Web Access has been installed on an IIS server,
your RightFax clients can access their fax mailboxes from Internet
Explorer version 6 or higher by entering the following URL:

http://ServerName/WebUtil

Where ServerName is the machine name of the IIS server where
Web Access is installed.

http://ServerName/WebUtil?server=test

Installing the SOAP client application

The SOAP client installation lets RightFax users use the
Print-to-Fax feature from any computer with an Internet connection.
The SOAP server must be installed on an IS server running version
9.3 of RightFax Web Access. The SOAP client then accesses
RightFax through that server. This provides RightFax functionality to
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home-office or other remote employees who do not have direct
access to your organization's network. There are two components
to the SOAP installation: install the SOAP server on the IIS
computer running RightFax Web Access, and then install the
SOAP client on the remote client computers.

Installing the SOAP Client

When you install the SOAP server on the Web Access IIS server,
the SOAP client installation file RightFax Client for the Web.exe is
installed in the Program Files\RightFax\WebApps\WebUtil\Client
Install folder. You must send this file via e-mail, copy it to a
removable storage medium, or otherwise make it available to the
remote clients. Follow these steps on each remote computer to
install the SOAP client:

1. Run the RightFax SOAP client installation file RightFax Client
for the Web.exe.

2. At the introductory screen, click Next.

3. Enter the Web address of the SOAP server (e.g.,
www.MyCompany.SOAPServer.com) and the machine name of
the RightFax server when prompted. Click Next.

4. Click Install to begin the installation. A status bar indicates the
progress of the installation.

5. When the installation is complete, click Finish.

Using the SOAP Client

After you install the RightFax SOAP client, a RightFax tray icon will
appear in the computer's notification area in the lower right corner
of the desktop. Users can access RightFax Print-to-Fax features
through the shortcut menu from this icon. Users can also print
documents directly to the RightFax Fax Printer (a new printer type
that the client installation adds), which prompts for fax addressing
information and transmits the document via the RightFax server.

Repairing the RightFax Server Installation

The RightFax Repair installation replaces missing or corrupted
RightFax program files or Windows Registry settings, and retains
your fax database and configuration settings.

To repair an installation

1. Insert the RightFax server CD. If AutoRun is enabled, a menu of
install options appears. If AutoRun is not enabled, browse the
CD and run AutoRun.exe.

2. In the menu of install options, select the option to install the
RightFax server. The RightFax install wizard opens.

3. Click Next at the opening screen, select the Repair option, and
then click Next.

4. Click Install to begin the Repair installation.

5. When the Repair installation is complete, click Finish.

Uninstalling the RightFax Server

To ensure that all RightFax components are completely uninstalled,
you must remove all separately installed RightFax components (the
fax hardware drivers, AutoReply, etc.) before uninstalling the
RightFax server. These components can be uninstalled from
Add/Remove Programs in Windows Control Panel.

Chapter 3 Installing the RightFax Server Software
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To uninstall the RightFax server

WarningWhen you uninstall the RightFax server, all RightFax program
files, Windows Registry settings, and shortcuts are removed. In addition,
all of your RightFax configuration settings are removed. The RightFax
database, however is not removed and must be manually removed using
SQL protocols. Captaris recommends that you back up the contents of
the entire RightFax folder before uninstalling the software. For
information on creating a backup of the RightFax server, refer to the
RightFax Administrator's Guide.

1. Insert the RightFax server CD. If AutoRun is enabled, a menu of
install options appears. If AutoRun is not enabled, browse the
CD and run AutoRun.exe.

2. In the menu of install options, select the option to install the
RightFax server. The RightFax install wizard opens.

3. Click Next at the opening screen, select the Remove option,
and then click Next.

4. Click Remove to uninstall the RightFax server.
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5. When the uninstall process is complete, click Finish.

Note The RightFax installation will use the first compatible printer driver
it finds to create the HPFAX printer. If no compatible driver is found,
RightFax will install one automatically. If this occurs, this driver and its
associated files will not be removed if RightFax is uninstalled. In a
Microsoft Windows 2000 and 2003 installation, the printer driver files
reside at ..Windows\System32\Spoo/\Drivers\W32X86\3 and include
the following:

e HPLJ5.BUD

e HPLJ5.GPD

e PCL5ERES.DLL

e STDNAMES.GPD

e TTFSUB.GPD

e UNIDRV.DLL

e UNIDRV.HLP

e UNIDRVUI.DLL

e UNIRES.DLL
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Using Enterprise Fax Manager

R

With the Enterprise Fax Manager program, an administrator can
manage users, groups, signatures, forms, printers, billing codes,
library documents, and more, for all RightFax servers from one
application.

Enterprise Fax Manager (EFM) is a client application that can be
run from any Windows 2000 or Windows 2003 computer, and it is
installed on the RightFax server computer when you run the server
installation.

Running the Enterprise Fax Manager program

After the RightFax server software has been installed, run
Enterprise Fax Manager from the Programs list in the Start menu.
When you run Enterprise Fax Manager for the first time, it will try to
log on under your network user ID. If you did not log on to the
network as “Administrator” a Login dialog box will appear. Enter a
user ID and password with RightFax administrative access.

Important When the RightFax server software is installed, a RightFax
user account is created called “administrator” with a blank password. Use
this account to open Enterprise Fax Manager for the first time. Once you
are running Enterprise Fax Manager, you can create a new administrative
account with password protection.

The Enterprise Fax Manager window

Enterprise Fax Manager displays data and statistics about RightFax
servers and the components of each server such as users and
groups. In the left pane of the window is a tree structure that
displays each of the fax servers on your network and each fax
server's components. To appear in this list, a RightFax server must
be opened. To open a RightFax server on your network, select

File > Open and enter the name of the server when prompted.

The right pane displays details of the selected fax server or
component. ltems listed on the right, such as individual users or
library documents, are referred to as database objects. Database
objects can be added, deleted, and modified according your
needs.

Figure 3.1 The Enterprise Fax Manager Window
~=loix

' RightFax Enterprise Fax Manager

f | Server Name [Wersion | Serial Number [Licensed channels | Time Funning [dd... [ ues +
@ PDXDSKO0T931 (. [8E0Ent.. [ent111111 1 |oooD:D4:46:26 (0%

k001391 [Mamed
& Users

gl Groups

Ly Signatues

= Foms

& Printers

>® Billing Codes

+ @l Library Documents
@ SM5/Pager Services
it Alets & Monitors

ling Flat

# Disling Rules
“EE] Prefix Tables

4 | _'lJ
4

For more information on configuring fax servers and database
objects using Enterprise Fax Manager, refer to the RightFax
Administrator’s Guide.
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Running Silent Installs of the Server
and Fax Board Drivers

Both the RightFax server and Fax Board Driver installation
programs uses Microsoft Windows Installer (Msiexec.exe), which is
an executable program that interprets packages and installs
products. Msiexec.exe enables you to install or upgrade the
RightFax server silently (without user interaction or prompts). A
silent installation can be used for a large-scale enterprise
deployment to multiple RightFax servers.

The installation program is not designed to run on a remote
computer. To use it to install on a remote computer, a third-party
application such as SMS is required.

The following table describes some of the Msiexec.exe installation
command line options you can use. For more detailed information
and additional options, please refer to Microsoft documentation for
Msiexec.exe.

Table 3a Command Line Options for Microsoft Windows Installer
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Table 3a Command Line Options for Microsoft Windows Installer (Continued)

Property

Parameters

Description

Property

Parameters Description

fi

path/filename Installs or configures a product from a

specified path and filename.

Use the format: /i path\filename

/l

[ijwlela]r|ulc|m]olp|v
[+[1Logfile

Specifies the path to a log file. Use the
following flags to indicate the information
to log:

i - Status messages

w - Nonfatal warnings

e - All error messages

a - Startup of actions

r - Action-specific records
u - User requests

¢ - Initial Ul parameters

m - Out-of-memory or fatal exit
information

o - Out-of-disk-space messages
p - Terminal properties

v - Verbose output

+ - Append to existing file

I - Flush each line to the log

Ukn

- Wildcard; log all information except
the v option. To include the v option,
specify “/I*v".
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Table 3a Command Line Options for Microsoft Windows Installer (Continued)

Property

Parameters

Description

Table 3a Command Line Options for Microsoft Windows Installer (Continued)

/q

n|b|r|f

Sets the user interface level.

n - Setup does not prompt the user for
information. It does not display progress
indicators as it installs, and it does not
display a completion message at the end
of the installation.

b - Setup does not prompt the user for
information, but it does display progress
indicators and a completion message at
the end of the installation.

r - Setup does not prompt the user for
information. It does display progress
indicators as it installs, but it does not
display a completion message at the end
of the installation.

f - Setup prompts the user for
information, and it does display progress
indicators and a completion message at
the end of the installation.

Property | Parameters

Description

reboot Force|Suppress
|ReallySuppress

Force - Always prompts for a reboot at
the end of the installation. The setup
program will prompt the user with an
option to reboot at the end. If there is no
user interface, the system automatically
reboots at the end of the installation.

Suppress - Suppresses prompts for a
reboot at the end of the installation. The
setup program will prompt the user with
an option to reboot during the installation
if it detects that a reboot is required to
complete the installation. If there is no
user interface, the system automatically
reboots if one is required to complete the
installation. Reboots at the end of the
installation. For example, reboots that are
caused by an attempt to install a file in
use are suppressed.

ReallySuppress - Suppresses all reboots
and reboot prompts if the setup program
detects that a reboot is required to
complete the installation. Suppresses all
reboots and reboot prompts at the end of
the installation. Both the reboot prompt
and the reboot itself are suppressed. For
example, reboots at the end of the
installation that are caused by an attempt
to install a file in use are suppressed.

To obtain information about installation errors, you must generate a

log file with the /L option. Problems with the installation or
configuration are preceded by “Error” in the log.

Chapter 3 Installing the RightFax Server Software
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As part of the silent installation, you must install Microsoft
Windows Installer, version 2.0 or later. This program is included on
the root of the RightFax server CD and is called Instmsiw.exe.

Running a silent install of the RightFax server software

There are also several advanced RightFax command line options
you can set, described in the following table. The command line
format for these options is option="value”

The silent install for RightFax does not support installing a separate
SQL database on the RightFax server. The silent installation option
can only be used when connecting to an existing SQL server.

Table 3b RightFax Advanced Command Line Options
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Table 3b RightFax Advanced Command Line Options (Continued)

Property Parameters | Description

RFLANGUAGE <language> | Specify what language the RightFax
clients will use. This is set to English
by default.

RFSERVERNAME | <servername> | Specify the RightFax server the

clients, IS, or remote services will
connect to. For clients, this sets the
server the client will open when first
installed. For IS and remote services
it is used to specify the server to
connect to for configuration info or
settings.

Property Parameters | Description
INSTALLLEVEL 1]2|3 Controls what features are visible to
the user.
¢ 1 = Clients with no EFM
¢ 2 = Clients with EFM
o 3 = All features available
IS_ SAQLSERVER_ | <database> | The name of the database to create
DATABASE on the SQL server. Default is
RightFax.
IS_SQOLSERVER_ |<password> | Password used to log on to the SQL
PASSWORD server if SQL authentication is used.
IS_SQLSERVER_ | <server> The name of the SQL server to
SERVER connect to.
IS_ SAQLSERVER_ | <user> User name used to log on to the SQL
USERNAME server if SQL authentication is used.

The install properties text file

You must specify RightFax server installation properties and
installed components in a file called ServerProperties.txt. A sample
properties text file is included on the RightFax server CD.
Unspecified properties use the default values. The RightFax server
properties are listed in “Table 3c: RightFax Server Installation
Properties” on page 37.

For a new server installation, the ServerProperties.txt file must
contain these settings:

INSTALL_SERVER = TRUE

RFLANGUAGE = English

SMTPHOST = <ServerName>

SERIALNUM = <SerialNumber>
WORKSRV_USERID = <Domain\UserName>
WORKSRV_PASSWORD = <Password>
INSTALLDIR = C:\Program Files\RightFax\
ALLUSERS =1

IS_SQLSERVER_SERVER = <Server>
IS_SQOLSERVER_USERNAME =<User>
IS_SQLSERVER_PASSWORD = <Password>
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For a server upgrade, the ServerProperties.txt file must contain IS_SQLSERVER_SERVER = <Server>

these settings:

INSTALL_SERVER = TRUE
RFLANGUAGE = English
ALLUSERS =1

Table 3c RightFax Server Installation Properties

IS_SQLSERVER_USERNAME = <User>
IS_SQLSERVER_PASSWORD = <Password>

Caution The RightFax silent install performs no error checking. If you
attempt to install components for which the server does not meet the
minimum requirements, the silent install will fail.

Property Value Description
SMTPHOST <servername> Specify the name of the SMTP server on the network through which fax documents that are addressed to
e-mail recipients will be sent.
INSTALLDIR <install path> Specify the path and the folder on the server where the RightFax software will be installed.
Default: c:\program The value must end with a backslash (\).
files\rightfax\
SERIALNUM <serial number> Specify the product serial number.
This property is required for new installations.
If you are upgrading from an earlier version, this property is not required. You must delete this line or comment
it from the properties text file so that it is not read by the installation program. If you keep this property in the
properties text file without specifying the product serial number, then the serial number that is stored on your
RightFax server will be deleted.
WORKSRV_ <password> This property is required for new installations. If you are upgrading from an earlier version, this property is not
PASSWORD required.
Specify the password for the service account that the RightFax services will use to start. This should be an
account with administrative privileges on the RightFax server.
The password is case-sensitive.
WORKSRV_USERID <domain\userlD> This property is required for new installations. If you are upgrading from an earlier version, this property is not
required.
Specify the domain or workgroup and user ID for the service account that the RightFax services will use to
start. This should be an account with administrative privileges on the RightFax server.
Use the format domain\userlD.
RFSERVERNAME <server> Specify the RightFax server the modules of the install will communicate with. This property is required for all
subfeatures except the server.

Chapter 3 Installing the RightFax Server Software
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Table 3¢ RightFax Server Installation Properties (Continued)
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Property Value Description

IUSRACCOUNT <userlD> Specify the anonymous IIS user account to use for IIS features.

ALLUSERS 10r0 Specify “1" to install for all users on the system, “0" to have it install for only the current user. This value must
be set to 1 for a server install.

NUMREMOTEWORK <number> Specify the number of remote WorkServers to install on the remote machine. This number must not push the

SERVERS total number of WorkServers above 16.

INOUTDIR <path\folder> Specify the directory to put the In/Out directories into for the Exchange 2000 Connector feature.

INSTALL_SERVER TRUE Set to “TRUE" to install the RightFax Server feature.

INSTALL_EFM TRUE Set to “TRUE" to install the Enterprise Fax Manager feature.

INSTALL_FAXCTRL TRUE Set to “TRUE" to install the RightFax Print Driver feature.

INSTALL_FAXUTIL TRUE Set to “TRUE" to install the FaxUtil feature.

INSTALL_OUTLOOK TRUE Set to “TRUE" to install the RightFax Outlook Client feature.

INSTALL_MAPI TRUE Set to “TRUE" to install the MAPI Print Driver feature.

PRINTER

INSTALL_VIMPRINTER TRUE Set to “TRUE" to install the VIM Print Driver feature.

INSTALL_AUTOREPLY TRUE Set to “TRUE" to install the AutoReply Client feature.

CLIENT

INSTALL_INTERACTION TRUE Set to “TRUE" to install the Interaction Client feature.

INSTALL_PAPERPORT TRUE Set to “TRUE" to install the Paperport Client feature.

INSTALL_ WEBEFM TRUE Set to “TRUE" to install Enterprise Fax Manager.

INSTALL_WEBCLIENT TRUE Set to “TRUE" to install the Web Client feature.

INSTALL_CERTIFIED TRUE Set to “TRUE" to install the Certified Delivery feature.

DELIVERY

INSTALL_EXCH2K TRUE Set to “TRUE" to install the Exchange 2000 MMC Client feature.

CLIENT

INSTALL_EXCH2K TRUE Set to “TRUE" to install the Exchange 2000 Connector feature.

CONNECTOR
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Table 3¢ RightFax Server Installation Properties (Continued)

Property Value Description

INSTALL_REMOTE TRUE Set to “TRUE" to install the Remote Alerting and Monitoring feature.
ALERTING

INSTALL_REMOTE TRUE Set to “TRUE” to install the Remote WorkServer feature.
WORKSERVER

INSTALL_REMOTE TRUE Set to “TRUE" to install the Remote Boardserver feature.
BOARDSERVER

INSTALL_JAVAXML TRUE Set to “TRUE" to install the Java/XML feature.

Chapter 3 Installing the RightFax Server Software
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The following is an example of a batch file that silently installs
Microsoft Windows Installer and the RightFax server. It generates
the log file named “RightFax Server.log”:

@echo calling silent install

@time /T

msiexec PROPERTIESFILE="c:\temp\ServerProperties.txt" /i
“D:\RightFax Product Suite.msi” /q /I*v “%temp%\RightFax
Server.log”

@time /T

After the silent installation, additional configuration of the server
may be needed. Refer to the RightFax Administrator's Guide for
instructions on configuring the server.

Running a silent install of the fax board drivers

You must specify fax board driver installation properties at the
command line or in a properties text file. An example properties text
file called HardwareProperties.txt is included on the root of the
RightFax server CD. The fax board driver properties are listed in the
following table.

Table 3d Fax Board Driver Installation Properties

Property Value | Description

BOARD_BROOK TRUE | Install Brooktrout fax board drivers.

You can specify both Brooktrout and
Intel Dialogic fax board drivers in the
command.

BOARD_DIALOGIC | TRUE | Install Intel Dialogic fax board
drivers.

You can specify both Brooktrout and
Intel Dialogic fax board drivers in the
command.
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Following is an example of a batch file that silently installs Microsoft
Windows Installer and the RightFax fax board drivers. It generates
the log file named “RightFax Hardware.log":

@echo calling silent hardware install

@time /T

msiexec PROPERTIESFILE="c:\temp\HardwareProperties.txt" /i
“D:\RightFax Fax Board Driver.msi" /q /I*v “%temp%\RightFax
Hardware.log”

@time /T

After the silent installation, additional configuration of the fax
boards may be needed. To configure the boards after installation
using the BoardServer configuration program, refer to the RightFax
Administrator's Guide.
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Chapter 4
Installing the RightFax Client Applications

The RightFax software includes the following client applications
that let RightFax users send and receive faxes via the RightFax
server and also let administrators manage RightFax servers from

remote computers:

“Enterprise Fax Manager” (page 41)

“RightFax Print Driver” (page 42)

“FaxUtil" (page 42)

“Outlook Advanced Fax Extensions” (page 42)
“MAPI Print Driver” (page 42)

“VIM Print Driver” (page 42)

“AutoReply Client” (page 42)

These client applications can be installed in the following
languages:

English

French
French-Canadian
German

ltalian
Portuguese
Spanish

Document Version xx-xxxx December 7, 2006

Before installing the RightFax client applications to your users’
computers, you should identify which applications are appropriate
for each user and then install only those applications.

Enterprise Fax Manager

Enterprise Fax Manager is a Windows-based application that
provides RightFax administrators access to all RightFax servers on
the network. Enterprise Fax Manager lets administrators manage all
aspects of the RightFax server including managing users and other
database objects, starting and stopping RightFax services, and
monitoring server statistics. This application should be installed on
all computers from which RightFax administrators will be managing
the servers. For information about running Enterprise Fax Manager,
refer to the RightFax Administrator's Guide.

A Web-based version of Enterprise Fax Manager (Enterprise Fax
Manager Web Edition) can be installed on a Microsoft IIS server on
your network. This version of Enterprise Fax Manager provides all
the same functionality as the Windows version, but is accessible
both locally and remotely via the Web using any Web browser. This
version of Enterprise Fax Manager is not installed as a client
application. For information on installing Enterprise Fax Manager
Web Edition, see “Installing the RightFax Web Applications” on
page 29.
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RightFax Print Driver

The RightFax Print Driver lets users fax documents directly from the
applications used to create them (such as Microsoft Word.) The
print driver also installs a RightFax tray icon in the Windows
taskbar that lets users configure fax options, run fax client
applications, send faxes, and set the default printer. This
application should be installed on all computers from which
RightFax users will be sending and receiving faxes.

FaxUtil

FaxUtil is a Windows-based fax mailbox tool that lets users send,
receive, view, edit, and manage faxes. This application should be
installed on all computers from which RightFax users will be
sending and receiving faxes, unless you will be installing alternative
client applications such as the RightFax Web Client, the Client for
Microsoft Outlook (described in the RightFax Gateway for
Microsoft Exchange Guide), or the Lotus Notes Client (described
in the RightFax Gateway for Lotus Notes Guide). For information
about running FaxUtil, refer to the FaxUtil online help which is
installed with FaxUtil.

A Web-based version of FaxUtil (RightFax Web Access) can be
installed on a Microsoft IIS server on your network. This version of
FaxUtil provides all the same functionality as the Windows version,
but is accessible both locally and remotely via the Web using any
Web browser. This RightFax mailbox tool is not installed as a client
application. For information on installing the RightFax Web Client,
see “Installing the RightFax Web Applications” on page 29.

Outlook Advanced Fax Extensions

The Outlook Advanced Fax Extensions enable advanced fax
functionality in your users’ Outlook mailboxes. This application
should be installed on computers running Microsoft Outlook only if
you will be installing the RightFax Gateway for Microsoft Exchange.
For information about using the Advanced Fax Extensions, refer to
the RightFax Gateway for Microsoft Exchange Guide.
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MAPI Print Driver

N

The RightFax MAPI (Messaging Application Programming
Interface) Print Driver lets fax users send fax images as e-mail
attachments using MAPI-compliant applications such as Microsoft
Outlook, Microsoft Mail, and Novell Groupwise. When the user
prints a document using this print driver, a MAPI-compliant e-mail
application window opens with the document attached as a TIFF
file. The e-mail message can then be addressed and sent. This
application should be installed on all computers to which you want
to provide this functionality. Before installing this application, make
sure that a PCL print driver is installed on the client's computer.

MAPI printing is currently not supported under Windows 2003
Terminal Server.

Note When faxing from Excel 97 with the MAPI print driver, in the Excel
Page Setup settings, set the print quality to 200 dots-per-inch (DPI) to
obtain the correct TIFF image quality.

VIM Print Driver

The RightFax VIM (Vendor Independent Messaging) Print Driver
lets fax users send fax images as e-mail attachments using
VIM-compliant applications such as Lotus Notes and Lotus cc:Mail.
When the user prints a document using this print driver, a
VIM-compliant e-mail application window opens with the document
attached as a TIFF file. The e-mail message can then be addressed
and sent. This application should be installed on all computers to
which you want to provide this functionality. Before installing this
application, make sure that a PCL print driver is installed on the
client’'s computer.

VIM printing is currently not supported under Windows 2003
Terminal Server.

AutoReply Client

The AutoReply service monitors one or more RightFax mailboxes
for inbound faxes and automatically faxes a response to the sender
based on each sender's caller service identification (CSID)
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number. The AutoReply Client lets administrators configure the
AutoReply service from any computer on the network This
application should be installed on all computers from which
RightFax administrators will be managing the AutoReply service.
For information about AutoReply, refer to the RightFax
Administrator's Guide.

RightFax Client Computer Requirements

RightFax client applications for this version can be installed only on
computers running the following operating systems:

¢ Microsoft Windows XP Professional, SP2
o Microsoft Windows 2000 Professional, SP4

The minimum hardware requirements for the client computer vary
depending on the operating system you are running.

Minimum hardware requirements for Microsoft Windows
2000 Professional and Windows XP Professional

Computer/Processor | 500 MHz or higher Pentium Ill compatible CPU
Memory 512 MB RAM
Hard drive 50 MB

CPU support

Up to two CPUs per computer

Drive CD-ROM or DVD drive

Display VGA monitor running at a resolution of 800 x
600 or higher

Keyboard/Mouse Required

Upgrading the RightFax Client Applications

a

Because newer versions of the RightFax client applications may not
be compatible with older versions of the RightFax server, all of the
RightFax servers on your network that will be accessed by fax users
should be upgraded before upgrading the client applications.

To upgrade existing client applications, complete the steps for
client installation (page 45).

Warning In FaxUtil versions 8.0 and later, users can create nested
folders, which is not supported in earlier versions. In an environment
where users can switch between FaxUtil version 8.0 (or later) and earlier
versions, any folders created in the later version of FaxUtil won't appear
in earlier versions of the client. Similarly, folders created in earlier
versions of FaxUtil will not appear in FaxUtil 8.0. However, folders
created in earlier versions of FaxUtil will appear in FaxUtil versions 8.5
and later in the All folder.

Important It is not possible to upgrade existing 8.7 and 9.0 clients to
RightFax 9.3 if you have installed these clients from an installation source
that has been updated to 8.7 SP3 or 9.0 SP2. These client versions must
be uninstalled before installing RightFax 9.3. Do note that it is possible to
perform a large-scale client uninstall using the RightFax installer. For
more information, see “Creating an Automated Client Uninstall” on

page 48.

Chapter 4 Installing the RightFax Client Applications
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Before You Begin

A

By default, the RightFax client installation will use the first
compatible printer driver it finds to create the RightFax Print Driver.
If no compatible printer driver is found, RightFax will install one
automatically.

Note If RightFax installs a printer driver automatically, this driver and its
associated files will not be removed if RightFax is uninstalled. In a
Microsoft Windows 2000 and XP Professional installation, the printer
driver files reside at..Windows\System32\Spoo/\Drivers\\W32X86\3 and
include the following:

e HPLJ5.BUD

e HPLJ5.GPD

e PCL5ERES.DLL

e STDNAMES.GPD

e TTFSUB.GPD

e UNIDRV.DLL

e UNIDRV.HLP

e UNIDRVUI.DLL

e UNIRES.DLL

You can force the client installation to use a specific printer driver
(if installed on the client computer) by modifying the file Setup.ini in
the folder that contains the Setup.exe file (described in the next
section). To specify a printer driver, edit the file Setup.ini with any
text editor. Add a new section entitled [CmdLine]. Add a property
to this section called PreferredDriver and set it to one of the
following values.

Value Print driver

-1 Select automatically (default)
0 PCL-5

1 PCL-5E

2 Adobe PostScript
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For example, to force the RightFax Print Driver installation to use
the Adobe PostScript print driver, add the following section to the
Setup.ini file:

[CmdLine]

PreferredDriver=2

In addition to requiring one of these printer drivers, all RightFax
client computers must have network access to the HPFAX print
queue on the RightFax server.

Decreasing FaxUtil load time

The time required for each user to load the FaxUtil client
application depends largely on the number of RightFax users
configured on the RightFax server that FaxUtil is accessing. If the
RightFax server contains a large number of users, FaxUtil may be
noticeably slow to load.

If the number of users configured on the RightFax server results in
slow FaxUtil load times, you can create a registry entry on client
computers that disables the automatic loading of users when
FaxUtil is run. The loading of user records will occur only if a user
performs actions in FaxUtil that require it.

You can disable the loading of two types of user: administered
users and unprotected users.

o Administered users are users that appear in a RightFax
administrator's or group administrator's FaxUtil mailbox.

e Unprotected users are users who have the Unprotected mailbox
permission set in their user profiles. These users appear in all
other FaxUtil user lists as though they had delegated everyone
else to allow them to access their fax mailboxes.

For RightFax administrators, disabling the loading of both
administered and unprotected may be necessary. For all other
FaxUtil users, it is only necessary to disable the loading of
unprotected users.
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To disable the loading of administered users

To disable the loading of administered users in FaxULtil on startup,
close FaxUtil and then add a REG_DWORD value called
LoadAdministeredUsers to HKEY_CURRENT_USER\
Software\RightFAX Client\FUW32 and set the value data to O
(zero).

To disable the loading of unprotected users

To disable the loading of unprotected users in FaxUtil on startup,
close FaxUtil and then add a REG_DWORD value called
LoadUnprotectedUsers to HKEY_CURRENT_USER\Software
\RightFAX Client\FUW32 and set the value data to O (zero).

To automatically disable user loading for new FaxUtil users

These REG_DWORD values can also be applied for all new
FaxUtil users on a particular computer. Modify the Windows
Registry to add the REG_DWORD values described above to
HKEY_LOCAL_MACHINE\Software\RightFAX Client\FUW32.
When users run FaxULtil for the first time, they will be automatically
configured to disable the loading of users.

RightFax Client Installation Methods

The RightFax client applications can be installed using any of the
following methods:

o “Installing the Client Applications from the RightFax CD"
(page 45)

e “Installing the Client Applications from a Network File
Share"(page 46)

e “Creating an Automated Client Install” (page 46)
e “Creating an Automated Client Uninstall” (page 48)

Installing the Client Applications
from the RightFax CD

Follow these steps to install the client applications directly from the
RightFax software CD. This method is recommended only if you
have a small number of RightFax client installations.

To install the RightFax client applications from the CD

1. Log on to the client computer and insert the RightFax server
CD. If AutoRun is enabled, a menu of install options appears. If
AutoRun is not enabled, browse the CD and run AutoRun.exe.

2. In the menu of install options, select the option to install the
RightFax product suite. The RightFax install wizard opens.

3. Click Next at the opening screen to view the RightFax license
agreement. You must accept the license agreement in order to
continue the installation. Click Next.

4. Enter your name, organization name, and your product serial
number when prompted. Click Next.

5. On the Setup Type screen, select Typical Client and then click
Next.

6. On the Custom Setup screen you can remove or select
additional client applications you want to install. Enterprise Fax
Manager, FaxUtil, the RightFax print driver, and the Microsoft
Outlook fax extension (for creating and sending faxes directly
from Microsoft Outlook) are already selected. When you have
selected the components to install, click Next.

7. On the Advanced Options screen, you will be prompted to
enter the RightFax Server Name. This option tells the client
software where to locate the RightFax server by default. You can
also change or add RightFax servers to connect to within each
client application.

Click Next.

8. Click Install to begin the installation.

Chapter 4 Installing the RightFax Client Applications
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Installing the Client Applications
from a Network File Share

You can install the RightFax client applications from a network file
share by copying the Client folder from the RightFax Product Suite
CD to a network file share and running setup. This installation,
however, does not provide the ability to upgrade existing client
applications. Existing clients you must be uninstalled prior to
attempting an installation using this method. To perform a
wide-scale removal of existing RightFax client applications, please
see the section “Creating an Automated Client Uninstall’on

page 48.

To install the RightFax client applications from the
network file share

1. Copy the Client installation folder from the root of RightFax
Product Suite CD to a network file share of your choosing.

2. Log on to the client computer and browse to the shared folder
on your network that contains the RightFax client install and run
setup.exe. The RightFax install wizard opens.

3. Click Next at the opening screen to view the RightFax license
agreement. You must accept the license agreement in order to
continue the installation. Click Next.

4. Enter your name and organization name when prompted. Click
Next.

5. On the Setup Features screen, remove or select additional
client applications you want to install. FaxUtil, the RightFax print
driver, and the Microsoft Outlook fax extension (for creating and
sending faxes directly from Microsoft Outlook) are already
selected. If you are unsure of the available disk space, select
the Space button to view a synopsis of what is disk space is
available. When you have selected the components to install,
click Next.
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6. On the Advanced Options screen, you will be prompted to
enter the RightFax Server Name. This option tells the client
software where to locate the RightFax server by default. You
can also change or add RightFax servers to connect to within
each client application.

Click Next.
7. Click Install to begin the installation.

Creating an Automated Client Install

If your network is equipped with Microsoft Systems Management
Server (SMS), LanDesk, or a similar network management system,
you can automate the installation of RightFax client software using
an SMS script or equivalent command. The RightFax client
installation program uses Microsoft Windows Installer
(Msiexec.exe) which, when run at a command prompt, can include
switches to force a quiet install, output an SMS status .smf file, and
more. Refer to Microsoft documentation on the Msiexec.exe for
detailed information on running it with a command.

You must install the RightFax client applications from a network file
share. Installation options are set in the installer settings file,
Setup.ini, which is located by default in the \Client folder on the file
server where you copy the client-only install.
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Modifying the command line

To create the command line, edit the Setup.ini file with a text editor.

In the [Startup] section, edit the CmdLine= command.

The following table describes the installation command switches
you can use. Refer to Microsoft documentation on the Windows

Installer for the latest information on these command line switches.

The following tables describe the command line options and
properties you can use..

Table 4a RightFax Advanced Command Line Options

Property

Parameters

Description

Switch

Description

/gb

Setup does not prompt the user for information. It
does display progress indicators and a completion
message at the end of the installation.

INSTALLLEVEL

12|38

Controls what features are visible to
the user.

e 1 = Clients with no EFM
¢ 2 = Clients with EFM
o 3 = All features available

/gn

Setup does not prompt the user for information. It
does not display progress indicators as it installs.
Does not display a completion message at the end
of the installation

RFLANGUAGE

<language>

Specify what language the RightFax
clients will use. This is set to English
by default.

/gr

Setup does not prompt the user for information. It
does display a completion message at the end of the
installation.

/gf

Setup prompts the user for information. It does
display progress indicators and a completion
message at the end of the installation.

RFSERVERNAME

<servername>

Specify the RightFax server the
clients, 11S, or remote services will
connect to. For clients, this sets the
server the client will open when first
installed. For IS and remote services
it is used to specify the server to
connect to for configuration info or
settings.

Chapter 4
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Table 4b RightFax Client Installation Properties

Property

Value

Description

RightFax 9.3 Feature Pack 1 Installation Guide

Table 4b RightFax Client Installation Properties (Continued)

INSTALLDIR

<install path>

Default: c:\program
files\rightfax\

Specify the path and the
folder on the server where
the RightFax software will
be installed.

The value must end with a
backslash (\).

SERIALNUM

<serial number>

Specify the product serial
number.

This property is required for
new installations.

If you are upgrading from an
earlier version, this property
is not required. You must
delete this line or comment
it from the properties text
file so that it is not read by
the installation program. If
you keep this property in
the properties text file
without specifying the
product serial number, then
the serial number that is
stored on your RightFax
server will be deleted.

Property Value Description
INSTALL_FAXCTRL TRUE Set to “TRUE" to install the
RightFax Print Driver
feature.
INSTALL_FAXUTIL TRUE Set to “TRUE" to install the
FaxUtil feature.
INSTALL_OUTLOOK TRUE Set to “TRUE" to install the
RightFax Outlook Client
feature.
INSTALL_MAPI TRUE Set to “TRUE" to install the
PRINTER MAPI Print Driver feature.
INSTALL_VIMPRINTER | TRUE Set to “TRUE" to install the
VIM Print Driver feature.
INSTALL_AUTOREPLY TRUE Set to “TRUE" to install the
CLIENT AutoReply Client feature.
INSTALL_INTERACTION | TRUE Set to “TRUE" to install the
Interaction Client feature.
INSTALL_PAPERPORT | TRUE Set to “TRUE” to install the
Paperport Client feature.
INSTALL_EXCH2K TRUE Set to “TRUE" to install the

CLIENT

Exchange 2000 MMC
Client feature.

ALLUSERS

1or0

Specify “1" to install for all
users on the system, “0" to
have it install for only the
current user. This value
must be set to 1 for a server
install.

INSTALL_EFM

TRUE

Set to “TRUE” to install the
Enterprise Fax Manager
feature.

Creating an Automated Client Uninstall

If your network is equipped with Microsoft Systems Management
Server (SMS), LanDesk, or a similar network management system,
you can automate the uninstallation of RightFax client software
using an SMS script or equivalent command. The RightFax client
installation program uses Microsoft Windows Installer
(Msiexec.exe) which, when run at a command prompt, can include
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switches to force a quiet install, output an SMS status .smf file, and
more. Refer to Microsoft documentation on the Msiexec.exe for
detailed information on running it with a command.

You must install the RightFax client applications from a network file
share. Installation options are set in the installer settings file,
Setup.ini, which is located by default in the \Client folder on the file
server where you copy the client-only install.

Modifying the command line

1. To create the command line, edit the Setup.ini file with a text
editor. In the [Startup] section, edit the CmdLine= command.

2. Remove all text following the CmdLine= entry.
3. Add the command of:

CmdLine=/gn Remove=All
4. Save and close Setup.ini.

You may now use your network management system software to
remove the RightFax clients. The options you have just entered will
uninstall the RightFax clients with no user interaction whatsoever
and will reboot all workstations (required). Upon restart, you may
proceed with the automated install as outlined in the section
“Creating an Automated Client Install” on page 46.

Configuring Windows 2000 and 2003 Terminal
Services to Support RightFax Client Sessions

RightFax client applications can be installed on and run in multiple
sessions from a Windows 2000 or 2003 Server using terminal
services. Running the RightFax client in the Windows terminal
server environment requires only one client install directly on the
server configured for terminal services, but supports an unlimited
number of simultaneous client sessions.

This installation also supports (but does not require) Citrix
MetaFrame.

To install the RightFax client using Windows 2000 or 2003
Terminal Services

1. Log on to the Windows server using an account with
administrative access.

2. Insert the RightFax Product Suite CD. Close the RightFax
splash screen if autorun is enabled.

3. On the Windows Server configured to use terminal services, go
to the Control Panel > Add/Remove Programs.

4. Choose Add New Programs.
5. Select the ‘CD or Floppy' or floppy button and click Next.

6. Browse to the Client\setup.exe file and click Open followed by
Next.

7. Install the RightFax client according to the instructions in the
section “RightFax Client Installation Methods” on page 45.

Troubleshooting the Client Installation
and Configuration

The following table lists the most common error messages that may
appear after installing the RightFax client applications with the
probable causes and solutions.

Error or error
message Possible solutions

The server is unavailable | Verify that the RightFax Database module
and RightFax RPC Server module
services are running on the RightFax
server.

The server is using Check the Networking program in

different network Control Panel on the Windows NT server
protocols and verify that the protocols installed and
enabled match those used by the clients.

Chapter 4 Installing the RightFax Client Applications
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Error or error
message

Possible solutions

The common network
protocol being used is
not routed between LAN
segments

o Try running a client on the same LAN
segment as that of the server. Modify
the appropriate bridge or routers to
route the proper protocols.

o Update the server and clients to use a
routed protocol.

o If the server machine has multiple
network adapters installed, try
removing all but one of the adapters
and allow other routers on the network
to route the packets.

Error or error
message

Possible solutions

There is no SAP agent
computer accessible to
both the client and server
machines

o Verify that the client and server
machines can log on to a NetWare
server. Verify that the SAP Agent is
installed on the Windows NT server.

o Verify that the client and server are on
the same network segment and that the
router between the segments is
configured to transport SAP type
0x640 messages.

The Windows NT server
running RightFax is not
configured to support
NetWare clients

Verify that the Windows NT server is
running gateway services for NetWare
and the SAP Agent. Verify that the
IPX/SPX transport is properly configured
using the Network program in Windows
Control Panel.

Unable to find FaxDB
service

Verify that the user logged in has access
to the RightFax host file server. If the

RightFax host file server is not a member,
backup, or primary domain controller,

then the user may not have access to the
RightFax files or resource \PIPE\FAXDB.
You may have to assign Guest privileges.

The NetWare clients are
using different frame
types than the Windows
NT server

On the client computer, the frame type is
in the Link Driver section of the
NET.CFG. On the Windows NT server,
the frame type is in the configuration of
the NWLink IPX/SPX transport object in
the Network program in Windows
Control Panel. If the Windows NT server
must support more than one frame type,
ensure that the internal network number
is a unique, non-zero number and that the

Auto Frame Type Detection is disabled.

User ID was not found in
database

RightFax has its own list of fax users and
the user ID specified is not on that list.
You can use Enterprise Fax Manager to
add users, either individually or by
reading them from the domain or file
server. When RightFax is first installed,
the users “Administrator” and “Default”
are loaded. Initially, neither user ID has a
password.

The password supplied
is incorrect

You must use the correct password for
the user specified. If the user has lost his
password, a RightFax administrator can
re-set the password in Enterprise Fax
Manager.
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Error or error
message

Possible solutions

The RightFax fax
addressing dialog box
opens, but nothing
appears in FaxUtil

¢ You are using a different user ID than
expected. Check the RightFax Client
program in Control Panel to see what
user ID the software is using.

e On Windows NT, the port setting for
the fax printer may be incorrect.
Complete the Configure Fax Printers
dialog box according to the instructions
in “Configuring Windows 2000 and
2003 Terminal Services to Support
RightFax Client Sessions” on page 49.
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Chapter 5

Installing RightFax in a Windows 2000

or Windows 2003 Cluster

AN

Caution Because the RightFax server software architecture is not fully
cluster-aware with replayable transaction logs, some in-process data may
be lost during a cluster failover. If failover occurs, faxes that were
in-process may fail conversion, may have fax conversion delayed, or may
be lost and unrecoverable.

Clustering RightFax with Microsoft
Windows 2000 Server

This section outlines how to install RightFax on an existing
Microsoft Windows 2000 Server cluster. This is not meant as a
general guide on clustering concepts, configuration, operation, or
support. It is recommended that you become familiar with
clustering concepts and the Windows 2000 Cluster Service prior
to beginning this procedure.

To view documentation on “Clustering RightFax with Microsoft
Windows 2003 Server”, see page 61.

System requirements
Installing RightFax in a Windows 2000 Server cluster environment
requires the following components.

o Two servers that are on the Microsoft Clustering Hardware
Compatibility List (located on the Microsoft Web site) that
possess two network cards.

¢ A local or remote SQL Server 2000 or 2005 installation.

e The Windows Cluster Service must be installed, configured, and
operational.

¢ Windows Message Queueing.

o Print services for Unix (if using the Integration Module).

o« MDAC 2.8 or higher.

e An external RAID array running either SCSI or fiber channel.

Supported Windows Operating Systems
¢ Microsoft Windows 2000 Advanced Server with SP4 installed
¢ Microsoft Windows 2000 Datacenter Server with SP4 installed

Chapter 5 Installing RightFax in a Windows 2000 or Windows 2003 Cluster
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SQL Server requirements

N

e When using a RightFax cluster, all versions of SOL Server must
be set to Mixed Mode, with SQL authentication enabled.

e SQL Server Standard Edition cannot be installed on the RightFax
cluster.

e SQL Server Enterprise Edition can be used on either a separate
hardware platform or as a clustered instance on the same
platform that will host RightFax.

Note For the purpose of the these instructions, the name “RightFax
group” will be used to designate the group where the RightFax services
are to be created, regardless of the actual group chosen. “Cluster IP
address” and “cluster name” will be used to designate the |IP address
and name of the virtual server used (the IP address and server name
resources contained within the RightFax group).

Configuring RightFax BoardServers

It is strongly recommended that no RightFax BoardServers be
installed on the clustered hardware. Phone lines and T1 lines
cannot be clustered and will not failover in the event of a hardware
problem. Captaris recommends that you use remote BoardServers,
connecting to the virtual RightFax server.

Configuring the Cluster Group

All of the clustered RightFax resources must be maintained in a
single cluster group. This provides complete failover protection in
the event of individual resource failures. This cluster group must
also include a disk resource, a server name resource, and an IP
address resource. The combination of these core resources
creates a virtual RightFax server. Configure the cluster group to
have a preferred server and to allow fail-back.

The default group created during the Cluster service installation,
named “Cluster Group,” may also be used for the RightFax
resources. In this case, the quorum drive is typically used as the
shared installation drive for the RightFax software. While this
approach may add complexity to recovery procedures in the event
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of a Cluster service or disk device failure, it will not affect
configuration or performance, and it is a good choice when
hardware resources are limited to a single logical drive.

For the purpose of these instructions, the name 'RightFax group'
will be used to designate the group where RightFax services are to
be created

Important If SQL Server is installed on the same cluster, it is
recommended that the RightFax resources be added to the same cluster
group which contains the SQL instance to be used. This will allow a
dependency to be created which will prevent the RightFax services from
attempting to start if the SQL instance is unavailable.

To create a clustered print spooler

Open Cluster Administrator.
Create a new print spooler resource in the RightFax group.
Create a directory on the shared drive called <drive:>\SPOOL.

Right click on Resources, then click New > Resource.

a e bhp =

The New Resource wizard will appear. In the name box, type the
name of the resource (such as RightFax Print Spooler). The
description can be the same as the resource name.

6. The Resource Type should be Print Spooler.
In the Possible Owners box, verify the presence of all nodes.

8. In the Resource Dependencies box, add the disk and network
name resources.

9. On the Parameters tab, type the path to the Spool directory on
the shared drive.

10.Click Finish to add the resource to the group.

11.Cluster the TCP/IP Print Server service. (This step is required
only if the RightFax Integration Module is to be installed.)
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12.Set the TCP/IP Print Server service (Print Services for Unix) to

manual startup on each node. Stop the services if currently
running.

13.Create a new Generic Service resource. Enter LPDSVC as the

service name.

14.From the properties dialog of the new service, select the print

spooler resource as a dependency.

To create cluster resources for required networking
services

1.

3.

Create a new Distributed Transaction Coordinator resource
in the RightFax group. This is done with the Comclust.exe utility
installed with the Windows 2000 Cluster Service. The MSDTC
resource must reside in the RightFax group. See Microsoft
documentation for more information on adding and configuring
the MSDTC service in a cluster.

Create a new Message Queuing resource in the RightFax
group. Make it dependent on the disk and network name
resources.

Bring all resources online.

To verify failover and failback

. Open Cluster Administrator on the second node.

Verify that the primary node currently owns all resources, and
that they are online.

Shut down the primary node and verify that all resources fail
over to the secondary node.

Restart the primary node and verify that all resources fail back.

Installing RightFax on each cluster node

1.

Ensure the primary node has control of the RightFax group,
including the shared drive to which RightFax will be installed.

On the primary node, run the RightFax 9.3 Prerequisites Setup
according to the instructions in Chapter 3, “Running the
Prerequisites Wizard”. Be sure to provide the network name of
either the clustered SQL Server instance (if used) or the name
of a remote SQL Server.

On the primary node, install the RightFax server software to the
shared drive according to the instructions in Chapter 3,
“Installing the RightFax Server Software” and the additional
requirements outlined below.

¢ Use a WorkServer service account that is a domain member
and has access to all nodes (local accounts cannot be used).

o If prompted to restart the computer at the end of the
installation, select No.

e Do not install the fax board hardware drivers.

Open the Windows Services management console and stop all
running RightFax services. Set all of the RightFax services to
manual start. Do not forget the Captaris Conversion Engine.

Open the Printers control panel on the primary node and stop
sharing the HPFAX printer.

From Cluster Administrator, move the RightFax group to the
second node. Wait for the resources to come back online.

Delete the entire RightFax directory from the shared drive.

8. Install RightFax on the second node, selecting the same options

as during the first installation. Remember to change the
installation location to the shared drive, not the default of
C:\ProgramFiles\RightFax.

When asked whether to overwrite the existing database or add
a new instance, select overwrite.
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10.Set all of the RightFax services to manual start, and stop any

that are running.

11.0pen the Printers control panel on the secondary node and

stop sharing the HPFAX printer.

To create the HPFAX print queue

1.

Open the Printer folder on the RightFax virtual server by typing
\\<cluster_name> from the Windows Run dialog found on the
Start menu. In Windows Explorer, open the Printers control
panel (folder).

Create a new TCP/IP port, using the shared cluster IP address
as the target |IP address and HPFAX as the port name.

. Select Custom Device Type, and click Settings. Select RAW

as the protocol and set the port number to 53199.

Select an HP LaserlJet I, Laserlet 4, or LaserJet 5 printer driver
and share the printer as HPFAX.

Open the Properties of the HPFAX printer, click the Advanced
tab, and then click Separator Page. Enter the following for the
separator page:

SharedDrive:\RightFax\bin\RightFax.sep

Where SharedDrive is the drive letter of the shared drive on
which RightFax is installed.

Re-start both nodes. Once restarted, the primary node should
have control of the RightFax group, including the shared drive.

Use Cluster Administrator to move the group to the node which
was installed LAST.
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Creating the RightFax Cluster Resources

To create the RightFax cluster resources, run Cluster Administrator
and open the RightFax cluster group. You will create the following

resources.

Table 5a RightFax Cluster Resources

Name of Resource

Type of Resource Service Name

RightFax File Share File Share N/A
Captaris Conversion Engine  Generic Service RFIsoConv
RightFax DocTransport Generic Service RFDocTrans
RightFax Server Module Generic Service RFServer
RightFax Queue Handler Generic Service RFqueue
RightFax RPC Server Module Generic Service RFRPC
RightFax Remoting Service Generic Service RFremote
RightFax Paging Module Generic Service RFpage
RightFax E-mail Gateway Generic Service RFEmail

To create the file share resource

1. Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

2. In the Name and Description boxes, enter “RightFax File

Share!

3. Set Resource Type to File Share.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the Disk Resource,
Network Name, and IP Address resources.
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9.

In the Generic File Share Parameters box, enter the path to
the RightFax directory on the shared drive. Be sure to use
RightFax as the share name.

On the Parameters tab, click the Permissions button. Give
“Everyone” both read and change permissions.

Click Finish to add the resource to the group

10.Bring the resource online.

To create the RightFax RPC Server Module resource.

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax RPC
Server Module!

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share” and the SQL server name (if
present).

In the Generic Service Parameters box, type “RFRPC!" Do not
select the “use network name for communications!”

Under Registry Replication, click Add and type
“SOFTWARE\RIightFax" This allows the registry information
stored by RightFax to dynamically change from one node to
another if the server goes down.

Click Finish to add the resource to the group.

To

1.

create the Captaris Conversion Engine resource
Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “Captaris
Conversion Engine”.

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

To

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share”.

In the Generic Service Parameters box, type “RFISOCONV".
Do not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

create the DocTransport Module resource
Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax
DocTransport Module™.

3. Set Resource Type to Generic Service.

Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax RPC
Module (RFRPC).

In the Generic Service Parameters box, type
“RFDOCTRANS". Do not select the “use network name for
computer name” checkbox.
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8.

Click Finish to add the resource to the group.

To create the RightFax Server Module resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax Server
Module”

3. Set Resource Type to Generic Service.

Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

8.

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax RPC
Module (RFRPC).

In the Generic Service Parameters box, type “RFSERVER!
Do not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the RightFax Queue Handler resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax Queue
Handler”

3. Set Resource Type to Generic Service.

Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share".

8.
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In the Generic Service Parameters box, type “RFQUEUE! Do
not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the RightFax Remoting Service resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax Remoting
Service”.

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

8.

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share".

In the Generic Service Parameters box, type “RFREMOTE".
Do not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the RightFax Paging Module resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In both the Name and Description boxes, enter “RightFax
Paging Module”

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.
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8.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share".

In the Generic Service Parameters box, type “RFPAGE” Do
not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the RightFax E-mail Gateway resource (if
installed)

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In both the Name and Description boxes, enter “RightFax
E-mail Gateway!

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

8.

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax Server
resource “RFSERVER".

In the Generic Service Parameters box, type “RFEMAIL! Do
not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To license your cluster

1.

Take the RightFax service resources offline. Do not take the
entire group offline.

Warning All RightFax services must be taken offline using Cluster
Administrator. Failure to do so will result in an immediate failover.

2,

From the node with ownership of the RightFax resources, open
the Server Module applet located in Windows control panel.

To

License your cluster by contacting the RightFax product
support group at (520) 320-7070. A support engineer will
assist you through the registration process.

Bring all resources online after successfully licensing your
cluster.

complete the cluster installation

. Bring all of the RightFax resources on-line.

From the node with ownership of the RightFax group, open
Regedit.

Browse to HKLM\SOFTWARE\RightFax\Install\. Change the
value RFServerName to reflect the shared network name of the
RightFax group, not the name of the node.

Browse HKLM\SOFTWARE\RightFax\Production\. Change the
value RightFaxServerName to the shared network name of the
RightFax group.

Browse to HKLM\SOFTWARE\RightFax\Production\Servers.
Here you will find a subkey with the same name as the node.
Rename this subkey to the shared network name of the
RightFax group.

From Cluster Administrator, verify that the RightFax group can
be taken offline and online without errors.

Move the group between the nodes, verifying that all the
resources start correctly on each node. Correct any issues
found before proceeding.

Make sure the RightFax resources are online. Install remote
BoardServers as required, pointing them to the shared network
name of the RightFax cluster group, rather than the name of any
individual node. When prompted during remote BoardServer
installation, select the option to use an existing SQL Server, and
supply the correct server name (clustered instance name if
applicable) and logon information

Chapter 5 Installing RightFax in a Windows 2000 or Windows 2003 Cluster
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Configuring the Integration Module in a Windows 2000
Cluster

Follow the instructions below if licensed for the Integration Module.
1.

A

From the active node, open the RightFax Integration applet from
the Windows Control Panel.

Note If the Integration applet does not appear in the Control Panel,
locate the Shared Files folder under the RightFax Directory, and open
rfprod_ctl.cpl to launch the applet.

Run the Integration Wizard or manually configure the Integration
Module. Do not close the applet.

Important Change the RightFax Server name to the shared
network name of the RightFax group.

Open the Windows registry and browse to the subkey:
HKLM\SOFTWARE\RightFax\Production\RFProd.

Modify the command line for the three default printer inputs so
that they use TCP/IP ports rather than named pipes by using
the table below. The numbers at the end of the new command
lines are the TCP/IP port numbers. You can select any port
number that is not in use on either node of the cluster.
Alternatively, you may delete and recreate existing inputs,
however, you must set the new inputs to the type of "TCP/IP
Port"

Table 5b

Printer Default Command Required Command
Name Line Line

HostFax portlstn -c "makedoc $$"

-p 8201

nplisten -¢ "makedoc
$$" -p hflpr

PCL nplisten -c "pfilter $$ |
makedoc" -p hfpcl

portlstn -c "pfilter $$ |
makedoc" -p 8202

Postscript nplisten -c "pfilter -p $$| portlstn -c "pfilter -p $$ |
makedoc" -p hfps makedoc" -p 8203
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If additional printer inputs are needed, create them in the same
way using TCP/IP ports. Named pipes will not function in the
cluster environment.

6. Click OK to close the applet and create the service.

7. Verify that the RightFax Integration Module service is set to

manual start.

8. Move the group to the second node.

9. Open the Integration applet on the second node. All

configuration settings should be retained. Click OK to close the
applet and create the service.

10.Verify that the RightFax Integration Module service is set to

manual start.

Create a new Generic Service resource in the RightFax
group

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In both the Name and Description boxes, enter “RightFax
Integration Module”

3. Set Resource Type to Generic Service.

Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

8.
9.

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax Server
resource “RFSERVER".

In the Generic Service Parameters box, type “RFPROD." Do
not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

Bring the new resource online.

10.Verify failover and failback is successful.
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Configure the Integration Module Printers

1. Click Start > Run, and enter \\<cluster_name>.

2. In Windows Explorer, open the Printers folder

Important You must open the cluster printer folder belonging to the
virtual machine, not the printer folder belonging to either node. If you
access the printers in the usual way from Start, Settings, Printers, you
are only opening the node's printer folder.

3. Create new ports for each of the printer inputs defined in the
Integration applet.

4. Create a new printer port of the "Standard TCP/IP Port" type.

5. Use the shared cluster IP address as the target IP address, and
HostFax as the port name.

6. Select "Custom" device type, click settings, and specify "RAW"
as the protocol, and the TCP/IP port number specified in the
Portlstn command line from the Production applet (8201 in the
example from the earlier step).

7. Repeat to create new printer ports for each of the other default
printer inputs, using HFPCL and HFPS as the port names, and
the TCP/IP port numbers specified in the applet. Also create
ports for any custom printer inputs to be used.

8. Create new printers for each Integration print queue. Use the
printer names HostFax, HFPCL, and HFPS, and the previously
created ports.

Important Use only Generic, Plain Text as the printer driver for
every Integration Module print queue

Using FTP with the Integration Module

If FTP is to be used for the Integration Module, add a virtual
directory to BOTH nodes using IS Manager, with the local path
being the \RightFax\Production\Inbox directory on the shared drive.
It is not necessary to cluster the FTP service.

Applying Service Packs or Hot Fixes

If it is necessary to apply a RightFax service pack or hot-fix after the
installation on the cluster has been completed, follow these steps:

1. Run Cluster Administrator and stop all RightFax services. Do
not take the RightFax file share offline.

2. Apply the update to the active node according to the
instructions provided with the update.

3. Move the group containing the RightFax services to the next
node without bringing them online.

4. Apply the update to the new node according to the instructions
provided with the update.

5. Apply the update to any remote BoardServers and
WorkServers, if applicable.

6. From Cluster Administrator, bring the RightFax services back
online.

Clustering RightFax with Microsoft
Windows 2003 Server

This section outlines how to install RightFax 9.3 on an existing
Microsoft Windows 2003 Server cluster. This is not meant as a
general guide on clustering concepts, configuration, operation, or
support. It is recommended that you become familiar with
clustering concepts and the Windows 2003 Cluster Service prior
to beginning this procedure.

Chapter 5 Installing RightFax in a Windows 2000 or Windows 2003 Cluster
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System requirements
Installing RightFax in a Windows Server 2003 cluster environment
requires the following components.

e Two servers that are on the Microsoft Clustering Hardware
Compeatibility List (located on the Microsoft Web site) that
possess two network cards.

e A local or remote SQL Server 2000 or 2005 installation.

e The Windows Cluster Service must be installed, configured, and
operational.

¢ Windows Application server component with Network
Distributed Transaction Coordinator and Message Queuing
installed.

« Print services for Unix (if using the Integration n Module).
e« MDAC 2.8 or higher.
An external RAID array running either SCSI or fiber channel.

Supported Windows Operating Systems
¢ Microsoft Windows Server 2003 Enterprise Edition
o Microsoft Windows Server 2003 Datacenter Edition

SQL Server requirements
e When using a RightFax cluster, all versions of SOL Server must
be set to Mixed Mode, with SQL authentication enabled.
e SQL Server Standard Edition cannot be installed on the RightFax
cluster.

e SQL Server Enterprise Edition can be used on either a separate
hardware platform or as a clustered instance on the same
platform that will host RightFax.
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Configuring RightFax BoardServers

It is strongly recommended that no RightFax BoardServers be
installed on the clustered hardware. Phone lines and T1 lines
cannot be clustered and will not failover in the event of a hardware
problem. Captaris recommends that you use remote BoardServers,
connecting to the virtual RightFax server.

Configuring the Cluster Group

All of the clustered RightFax resources must be maintained in a
single cluster group. This provides complete failover protection in
the event of individual resource failures. This cluster group must
also include a disk resource, a server name resource, and an |IP
address resource. The combination of these core resources
creates a virtual RightFax server. Configure the cluster group to
have a preferred server and to allow fail-back.

The default group created during the Cluster service installation,
named “Cluster Group,” may also be used for the RightFax
resources. In this case, the quorum drive is typically used as the
shared installation drive for the RightFax software. While this
approach may add complexity to recovery procedures in the event
of a Cluster service or disk device failure, it will not affect
configuration or performance, and it is a good choice when
hardware resources are limited to a single RAID controller.

For the purpose of these instructions, the name 'RightFax group'
will be used to designate the group where RightFax services are to
be created.

R] Important If SQL Server is installed on the same cluster, it is

recommended that the RightFax resources be added to the same cluster
group which contains the SQL instance to be used. This will allow a
dependency to be created which will prevent the RightFax services from
attempting to start if the SQL instance is unavailable.
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To create a clustered print spooler

Open Cluster Administrator.

Create a new print spooler resource in the RightFax group.

Right click on Resources, then click New > Resource.

a ke bd =

name of the resource (such as RightFax Print Spooler). The
description can be the same as the resource name.

6. The Resource Type should be Print Spooler.

7. In the Possible Owners box, verify the presence of all nodes.

8. In the Resource Dependencies box, add the disk and network

name resources.

9. On the Parameters tab, type the path to the Spool directory on

the shared drive.
10.Click Finish to add the resource to the group.

11.Cluster the TCP/IP Print Server service. (This step is required
only if the RightFax Integration Module is to be installed.)

12.Set the TCP/IP Print Server service (Print Services for Unix) to

manual startup on each node. Stop the services if currently
running.

13.Create a new Generic Service resource. Enter LPDSVC as the

service name.

14.From the properties dialog of the new service, select the print
spooler resource as a dependency.

Create a directory on the shared drive called <drive:>\SPOOL.

The New Resource wizard will appear. In the name box, type the

To

create cluster resources for required networking

services

1.

From Cluster Administrator, take the network name resource in
the RightFax group offline.

Edit the properties of the network name resource. Click the
Parameters tab and select “Enable Kerberos Authentication”
and click OK.

3. Bring the network name resource back online.

4. Create a new Distributed Transaction Coordinator resource

To

in the RightFax group. Make it dependent on the disk and
network name resources. See Microsoft documentation for
more information on adding and configuring the MSDTC service
in a Windows 20083 cluster.

Create a new Message Queuing resource in the RightFax
group. Make it dependent on the disk and network name
resources.

Bring all resources online.

verify failover and failback

. Open Cluster Administrator on the second node.

. Verify that the primary node currently owns all resources, and

that they are online.

Shut down the primary node and verify that all resources fail
over to the secondary node.

Restart the primary node and verify that all resources fail back.
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Installing RightFax on each cluster node

1.

Ensure the primary node has control of the RightFax group,
including the shared drive to which RightFax will be installed.

On the primary node, run the RightFax 9.3 Prerequisites Setup
according to the instructions in Chapter 3, “Running the
Prerequisites Wizard”. Be sure to provide the network name of
either the clustered SQL Server instance (if used) or the name
of a remote SQL Server.

On the primary node, install the RightFax server software to the
shared drive according to the instructions in Chapter 3,
“Installing the RightFax Server Software” and the additional
requirements outlined below.

o Use a WorkServer service account that is a domain member
and has access to all nodes (local accounts cannot be used).

o If prompted to restart the computer at the end of the
installation, select No.

e Do not install the fax board hardware drivers.

Open the Windows Services management console and stop all

running RightFax services. Set all of the RightFax services to
manual start. Do not forget the Captaris Conversion Engine.

Open the Printers control panel on the primary node and stop
sharing the HPFAX printer.

From Cluster Administrator, move the RightFax group to the
second node. Wait for the resources to come back online.

7. Delete the entire RightFax directory from the shared drive.

Install RightFax on the second node, selecting the same options
as during the first installation. Remember to change the
installation location to the shared drive, not the default of
C:\ProgramFiles\RightFax.

When asked whether to overwrite the existing database or add
a new instance, select overwrite.
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10.Set all of the RightFax services to manual start, and stop any

that are running.

11.0pen the Printers control panel on the secondary node and

stop sharing the HPFAX printer.

To create the HPFAX print queue

1.

Open the Printer folder on the RightFax virtual server by typing
\<cluster_name> from the Windows Run dialog found on the
Start menu. In Windows Explorer, open the Printers control
panel (folder).

Create a new TCP/IP port, using the shared cluster IP address
as the target IP address and HPFAX as the port name.

Select Custom Device Type, and click Settings. Select RAW
as the protocol and set the port number to 53199.

Select an HP Laserlet I, Laserlet 4, or LaserJet 5 printer driver
and share the printer as HPFAX.

Open the Properties of the HPFAX printer, click the Advanced
tab, and then click Separator Page. Enter the following for the
separator page:

SharedDrive:\RightFax\bin\RightFax.sep

Where SharedDrive is the drive letter of the shared drive on
which RightFax is installed.

Re-start both nodes. Once restarted, the primary node should
have control of the RightFax group, including the shared drive.

Use Cluster Administrator to move the group to the node which
was installed LAST.
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Creating the RightFax Cluster Resources

To create the RightFax cluster resources, run Cluster Administrator
and open the RightFax cluster group. You will create the following
resources.

Table 6¢ RightFax Cluster Resources

Name of Resource

Type of Resource Service Name

RightFax File Share File Share N/A
Captaris Conversion Engine  Generic Service RFIsoConv
RightFax DocTransport Generic Service RFDocTrans
RightFax Server Module Generic Service RFServer
RightFax Queue Handler Generic Service RFqueue
RightFax RPC Server Module Generic Service RFRPC
RightFax Remoting Service Generic Service RFremote
RightFax Paging Module Generic Service RFpage
RightFax E-mail Gateway Generic Service RFEmail

To create the File Share resource

1.

Generic Resource wizard opens.

Share!

3. Set Resource Type to File Share.

4. Select the RightFax group.

Right-click Resources, and then select New > Resource. The

In the Name and Description boxes, enter “RightFax File

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

Network Name, and IP Address resources.

In the Resource Dependencies box, add the Disk Resource,

9.

In the Generic File Share Parameters box, enter the path to
the RightFax directory on the shared drive. Be sure to use
RightFax as the share name.

On the Parameters tab, click the Permissions button. Give
“Everyone” both read and change permissions.

Click Finish to add the resource to the group

10.Bring the resource online.

To create the RightFax RPC Server Module resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax RPC
Server Module!

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share” and the SQL server name (if
present).

In the Generic Service Parameters box, type “RFRPC! Do not
select the “use network name for communications.”

Under Registry Replication, click Add and type
“SOFTWARE\RightFax" This allows the registry information
stored by RightFax to dynamically change from one node to
another if the server goes down.

Click Finish to add the resource to the group.
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To create the Captaris Conversion Engine resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “Captaris
Conversion Engine”.

3. Set Resource Type to Generic Service.

Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

8.

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share”.

In the Generic Service Parameters box, type “RFISOCONV™.
Do not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the DocTransport Module resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax
DocTransport Module™.

3. Set Resource Type to Generic Service.

Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax RPC
Module (RFRPC).

In the Generic Service Parameters box, type
“RFDOCTRANS". Do not select the “use network name for
computer name” checkbox.

8.
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Click Finish to add the resource to the group.

To create the RightFax Server Module resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax Server
Module!

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

8.

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax RPC
Module (RFRPC.exe).

In the Generic Service Parameters box, type “RFSERVER!
Do not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the RightFax Queue Handler resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax Queue
Handler”

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share".
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8.

In the Generic Service Parameters box, type “RFQUEUE” Do
not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the RightFax Remoting Service resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

In the Name and Description boxes, enter “RightFax Remoting
Service”.

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

8.

the cluster by selecting them and clicking Add.

In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share".

In the Generic Service Parameters box, type “RFREMOTE".
Do not select the “use network name for computer name”
checkbox.

Click Finish to add the resource to the group.

To create the RightFax Paging Module resource

1.

Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

. In both the Name and Description boxes, enter “RightFax

Paging Module”

3. Set Resource Type to Generic Service.

4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in

the cluster by selecting them and clicking Add.

a

6. In the Resource Dependencies box, add the RightFax file
share name- “RightFax File Share".

7. In the Generic Service Parameters box, type “RFPAGE! Do
not select the “use network name for computer name”
checkbox.

8. Click Finish to add the resource to the group.

To create the RightFax E-mail Gateway resource (if
installed)

1. Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

2. In both the Name and Description boxes, enter “RightFax
E-mail Gateway!

3. Set Resource Type to Generic Service.
4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in
the cluster by selecting them and clicking Add.

6. In the Resource Dependencies box, add the RightFax Server
resource “RFSERVER".

7. In the Generic Service Parameters box, type “RFEMAIL" Do
not select the “use network name for computer name”
checkbox.

8. Click Finish to add the resource to the group.
To license your cluster

1. Take the RightFax service resources offline using Cluster
Administrator. Do not take the entire group offline.

Warning All RightFax services must be taken offline using Cluster
Administrator. Failure to do so will result in an immediate failover.
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2. License your cluster by contacting the RightFax product
support group at (520) 320-7070. A support engineer will
assist you through the registration process.

3. Bring all resources online after successfully licensing your
cluster.

To complete the cluster installation

1. Bring all of the RightFax resources on-line.

2. From the node with ownership of the RightFax group, open
Regedit.

3. Browse to HKLMA\SOFTWARE\RightFax\Install\. Change the
value RFServerName to reflect the shared network name of the
RightFax group, not the name of the node.

4, Browse HKLM\SOFTWARE\RightFax\Production\. Change the
value RightFaxServerName to the shared network name of the
RightFax group.

5. Browse to HKLM\SOFTWARE\RightFax\Production\Servers.
Here you will find a subkey with the same name as the node.
Rename this subkey to the shared network name of the
RightFax group.

6. From Cluster Administrator, verify that the RightFax group can
be taken offline and online without errors.

7. Move the group between the nodes, verifying that all the
resources start correctly on each node. Correct any issues
found before proceeding.

8. Make sure the RightFax resources are online. Install remote
BoardServers as required, pointing them to the shared network
name of the RightFax cluster group, rather than the name of any
individual node. When prompted during remote BoardServer
installation, select the option to use an existing SQL Server, and
supply the correct server name (clustered instance name if
applicable) and logon information
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Configuring the Integration Module in a Windows 2003
Cluster

Follow the instructions below if licensed for the Integration Module.

1. From the active node, open the RightFax Integration applet from
the Windows Control Panel.

N Note If the Integration applet does not appear in the Control Panel,

locate the Shared Files folder under the RightFax Directory, and open
rfprod_ctl.cpl to launch the applet.

2. Run the Integration Wizard or manually configure the Integration
Module. Do not close the applet.

R] Important Change the RightFax Server name to the shared

network name of the RightFax group.

3. Open the Windows registry and browse to the subkey:
HKLM\SOFTWARE\RightFax\Production\RFProd.

4. Modify the command line for the three default printer inputs so
that they use TCP/IP ports rather than named pipes by using
the table below. The numbers at the end of the new command
lines are the TCP/IP port numbers. You can select any port
number that is not in use on either node of the cluster.
Alternatively, you may delete and recreate existing inputs,
however, you must set the new inputs to the type of "TCP/IP

Port"
Table 5d
Printer Default Command Required Command
Name Line Line
HostFax  nplisten -c "makedoc portlstn -c "makedoc $$"
$$" -p hflpr -p 8201
PCL nplisten -c "pfilter $$|  portlstn -c "pfilter $$ |

makedoc" -p hfpcl makedoc" -p 8202

Postscript nplisten -c "pfilter -p $$| portlstn -c "pfilter -p $$ |
makedoc" -p hfps makedoc" -p 8203
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5. If additional printer inputs are needed, create them in the same
way using TCP/IP ports. Named pipes will not function in the
cluster environment.

6. Click OK to close the applet and create the service.

7. Verify that the RightFax Integration Module service is set to
manual start.

8. Move the group to the second node.

9. Open the Integration applet on the second node. All
configuration settings should be retained. Click OK to close the
applet and create the service.

10.Verify that the RightFax Integration Module service is set to
manual start.

Create a new Generic Service resource in the RightFax
group

1. Right-click Resources, and then select New > Resource. The
Generic Resource wizard opens.

2. In both the Name and Description boxes, enter “RightFax
Integration Module!

3. Set Resource Type to Generic Service.
4. Select the RightFax group.

5. In the Possible Owners box, enter the names of both nodes in
the cluster by selecting them and clicking Add.

6. In the Resource Dependencies box, add the RightFax Server
resource “RFSERVER".

7. In the Generic Service Parameters box, type “RFPROD." Do
not select the “use network name for computer name”
checkbox.

8. Click Finish to add the resource to the group.
9. Bring the new resource online.

10.Verify failover and failback is successful.

Configure the Integration Module Printers

1. Click Start > Run, and enter \\<cluster_name>.

2. In Windows Explorer, open the Printers folder

Important You must open the cluster printer folder belonging to the
virtual machine, not the printer folder belonging to either node. If you
access the printers in the usual way from Start, Settings, Printers, you
are only opening the node's printer folder.

3. Create new ports for each of the printer inputs defined in the
Integration applet.

4. Create a new printer port of the "Standard TCP/IP Port" type.

5. Use the shared cluster IP address as the target IP address, and
HostFax as the port name.

6. Select "Custom" device type, click settings, and specify "RAW"
as the protocol, and the TCP/IP port number specified in the
Portlstn command line from the Production applet (8201 in the
example from the earlier step).

7. Repeat to create new printer ports for each of the other default
printer inputs, using HFPCL and HFPS as the port names, and
the TCP/IP port numbers specified in the applet. Also create
ports for any custom printer inputs to be used.

8. Create new printers for each Integration print queue. Use the
printer names HostFax, HFPCL, and HFPS, and the previously
created ports.

Important Use only Generic, Plain Text as the printer driver for
every Integration Module print queue

Using FTP with the Integration Module

If FTP is to be used for the Integration Module, add a virtual
directory to BOTH nodes using IS Manager, with the local path
being the \RightFax\Production\Inbox directory on the shared drive.
It is not necessary to cluster the FTP service.
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Applying Service Packs or Hot Fixes

If it is necessary to apply a RightFax service pack or hot-fix after the
installation on the cluster has been completed, follow these steps:

1.

Run Cluster Administrator and stop all RightFax services. Do
not take the RightFax file share offline.

. Apply the update to the active node according to the

instructions provided with the update.

Move the group containing the RightFax services to the next
node without bringing them online.

Apply the update to the new node according to the instructions
provided with the update.

. Apply the update to any remote BoardServers and

WorkServers, if applicable.

From Cluster Administrator, bring the RightFax services back
online.

RightFax 9.0 Feature Pack 1 Installation Guide

70



Chapter 6
Installing and Configuring RightFax Data Sharing

Data Sharing with RightFax 9.3 Server Topology

The capacity of RightFax servers can be multiplied by combining
two or more servers that share a common SQL database. This is
accomplished by installing and configuring multiple RightFax
servers to share a RightFax database and corresponding resource
folders. Benefits of Data Sharing may include:

¢ Increased throughput for sending faxes due to internal load
sharing among RightFax services.

o Multiple RightFax servers share all SQL stored data (e.g., users,
delegates, phonebook entries, distribution lists, and document
data such as fax status).

o All received faxes are stored on the SQL server and are available
to all clients in the network.

¢ Redundant data is eliminated thus saving storage space.

¢ RightFax does not limit the number of RightFax servers that can
share a common SQL database thus increasing scalability.

¢ Remote RightFax services can be shared by multiple machines to
balance the workload from many RightFax clients.

Note This feature is only available on RightFax 9.3 Enterprise Servers
and must be purchased separately.

The following examples describe some basic shared
configurations.

Figure 6.1 Two RightFax servers share a SQL database. Common disk
storage is used to store shared RightFax resources.

b

Common disk
storage®

=

RightFax RightFax

Server A Server B
Local outbound Local outbound
services services

*Common disk storage:
- SAN
- Network share on file server
- Network access to a local drive
on one of the RightFax servers
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Figure 6.3 Two RightFax servers share a SQL database. DocTransport
and WorkServer services are located on remote servers to off-load
processing from the RightFax servers. Dialing rules specify the
DocTransport services and RightFax servers from which documents will
be sent. Common disk storage is used to store shared RightFax

Figure 6.2 Two RightFax servers share a SQL database. DocTransport
services are located on remote servers to off-load processing from the
RightFax servers. Dialing rules specify the DocTransport services and
RightFax servers from which documents will be sent. Common disk
storage is used to store shared RightFax resources.
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Figure 6.4 Two RightFax servers share a SQL database. Common disk
storage is used to store shared RightFax resources. An application traffic

Installing RightFax Servers to Share a SQL
Database

manager, such as BIG IP, directs RightFax client traffic to available
RightFax servers.

Common disk
storage®

RightFax

RightFax

Saerver A L Server B
Local outhound | | Local outbound
services services
Application
traffic manager
Clients Clients
Clients

*Common disk storage:
- Network share on file server

- Network access to a local drive
on one of the RightFax servers

System Requirements

The requirements for RightFax Servers are described on page 9,
“Hardware and Software Requirements”. In addition to these
requirements, you must also possess a minimum of two servers
capable of network communication. Each of these must be
licensed for the ‘Server Collective’ feature.

To install multiple RightFax servers that share a SQL database,
complete the general steps below in conjunction with the
installation instructions outlined in Chapter 3, “Installing the
RightFax Server Software” or if necessary Chapter 5, “Installing
RightFax in a Windows 2000 or Windows 2003 Cluster”. If adding

1. If you are upgrading, print or make a copy of the Windows
registry key HKEY_LOCAL_MACHINE\ Software\RightFax so
that you have a copy of any changes that have been made to
customize the system. In a typical shared database
configuration, customization should be identical on each
RightFax server.

2. Install the RightFax server on the first RightFax server computer.
Define the SQL database as you are prompted during the
installation.

Important |If adding a server to a collective, the RightFax database
must be named ‘RightFax’ If you have renamed your RightFax database,
it's default name must be restored before continuing. After completing the
collective install you may rename the database to a name of your
choosing. See Microsoft documentation for information outlining how to
rename a SQL database.

3. Activate licensed features on the first RightFax server computer.

4. On the second RightFax server computer, run the RightFax
server installation program.

5. During the installation, point the second RightFax server to the
SQL database that you defined when you installed the first
RightFax server.

6. During the installation, you will be prompted to overwrite or
append to the existing database. Select to Append.
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7. Activate licensed features on the second RightFax server, as
described in step 2. To avoid license conflicts and violations, alll
of the RightFax servers that share a common SQL database
must have the same licensed features activated.

8. Repeat steps 4 through 7 for each added RightFax server.
Important In a server collective, each server must have a DocTransport

configured for outbound faxing or have dialing rules that specify a fax be
sent from a specific server.

Providing Access to Shared Resource Folders

Each RightFax Server that is licensed for Server Collective (Data
Sharing) will have a Data Sharing tab within the Server module
configuration as shown below.

Figure 6.5 The Server module Data Sharing Tab.

i";'| Server Configuration - LOCAL, Base Level, Version 9.30

General Advanced Feature Activation Custom Messages Usar Messages
Admin T-!e_ssages Data Sharing eTransport

‘When sharing data between RightF ax servers, a central storage location must be used for each type of resource file.
The following fields indicate where each lype of resource file will be stored. Thiz can be a UNC path or a shared cluster
drive.

[C1Uise this root palh for 2l fle ypes] | C:\Program File<\RightF a\
Images: | C:\Program FilestRightF as\IMAGEY
Signatures: | C:\Program Filesh\RightF 2\ SIGY
Forms: | C:\Program Files\RightF ax\PAPERS\
Cowver sheetz: | C:\Program Files\RightF a\FCSY
Qutgoing files: | C:\Program Files\RightF ax\OUTGOING
Atachments: | C\Program Files\RightF a\BF T\

Native documents: C:\Program Files\RightF sx\CMDDAT A\

BOUBOBBE

The server can be configured, using the button below. to use a service account that has full contol for fles in the above
locations. Other services can be configured in their respective conliol panels.

[ ok ][ canca |

The fields within the Data Sharing tab represent folders that must
be shared among all the RightFax servers within a Data Sharing
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environment. Share permissions must be given to the account used
to run both the Server module and DocTransport module. This
account must have full control of these folders. Choosing this
account can be done by click the Select Service Account button.

The Remote Service Paths button (avaiable with Hotfix 1) allows
you to specify paths to the \RightFax\Image directory on Remote
DocTransport servers.

For Example:
\\<Shared Storage>\RightFax\Image
\\<Shared Storage>\D$\RightFax\Image
\\<ip address>\RightFax\Image
\\<Shared Storage>|RightFax\Image

A complete list and description of the shared data folders is
provided below.

« Image (contains sent and received faxes stored as compressed
graphic image files).

« SIG (contains graphic images of user signatures for placement
on faxes).

o Papers (contains the names of overlay form files).
« FCS (contains fax cover sheets).
« Outgoing (contains outbound files from all submission methods

that are held while being processed into fax images, such as
temporary fax queue spool files).

o BFT (contains text files created by the OCR process).

e CmdData (contains transaction files for each fax sent via e-mail
or via SecureDocs).

Each of these folders can be located in common disk storage, such
as a storage area network (SAN), network share on file server, or
network access to a local drive on one of the RightFax servers. The
folders must be accessible to all the servers in the shared
configuration.
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On each RightFax server, create shared access to these files using
the RightFax Server Configuration dialog box > Data Sharing tab.
Access to these locations can be expressed differently for each
server due to permissions and network layout. Each server can be
configured to use unique paths and user accounts to the same
storage location for each type of resource file. Services that directly
access image and other files must be given service accounts with
access to the specified paths.

For Example:Server A may access a local storage area network
(SAN) using the path S:\RightFax\Image and use the
local system account for RightFax services to access
this path. Server B might access the same location
remotely using the path \\ServerA\RightFax\Image which
would require use of an account that had permissions to
access that network path (such as, DomainA\RightFax).

Configuring Remote Services

The following RightFax services can be installed on remote
computers.

¢ DocTransport specifies the methods by which documents will be
transmitted and converts and copies received documents to the
Image directory.

o BoardServer communicates between the RightFax server and
fax boards.

o WorkServer performs processor-intensive functions such as
cover sheet generation, print-to-fax conversion, and optical
character recognition.

To support remote fax board services, the DocTransport and
BoardServer modules must be installed together on Remote
BoardServer computers.

The DocTransport module must be defined on each RightFax
server. That is, whether local or remote, DocTransport modules
should be discrete and should not be shared. A remote
DocTransport module can connect to one RightFax server. It
cannot access multiple RightFax servers.

A remote BoardServer module can connect to one RightFax server.
It cannot access multiple RightFax servers. Information about
installing and configuring Remote DocTransports and Remote
BoardServers, see “Configuring the DocTransport and
BoardServer Modules” in Ch. 5 of the RightFax Administrator’s
Guide.

A remote WorkServer can connect to one RightFax server. It
cannot access multiple RightFax servers. Refer to Figure 7.2 on
page 72 for a basic illustration of remote services.

Using Dialing Rules

A fax may be sent by any server using the shared database, not
necessarily the one that initially received the job.

To specify that a fax be sent from a specific server, use dialing
rules. More information on dialing rules can be found in the
RightFax Administrator’'s Guide.

Refer to Figure 3 on page 72 for a basic illustration.

Performing Daily Maintenance

Maintenance is a collection of daily tasks that help maintain an
efficient SQL database. Maintenance tasks may be run by any
server on a first come first serve basis.

Aging and Purging

The aging process evaluates the age of each document on the
RightFax server. When a document exceeds the age limit, it is
marked for deletion. The marked documents will later be deleted by
the purge process. Documents that are marked for deletion can be
recovered until they are purged. The age limit for documents is
defined for each RightFax user group (in Enterprise Fax Manager).
Documents that are marked for deletion can also be queried for
reporting purposes.

Chapter 6 Installing and Configuring RightFax Data Sharing
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The purging process removes documents from the SQL database
that are both marked for deletion and have reached the configured
limit. The purging process deletes the corresponding image files
that are stored in the Image directories on the RightFax servers in
the shared configuration. One event triggers the aging and purging
process.

Orphan Scanning

The orphan process scans the RightFax\Image directories on the
RightFax servers for fax image files that are not referenced by any
document or library document in the SQL database. The image
files are called “orphans” because RightFax has no record of their
existence and cannot access them.

To manually delete orphan image files from the RightFax server, use
the Orphan.exe utility.

Recovery

The RightFax 9.3 the event queue is stored in the SQL database
on the SQL server, and it is shared among RightFax servers. The
queue is persistent, that is, it retains its objects and values if the
RightFax Server module stops. If one of the RightFax Server
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modules in the shared configuration stops, then it is not necessary
to rebuild the queue. The recovery process is performed daily on
the RightFax servers as a fail safe.

Configuring the Maintenance Processes

Each maintenance process is an event that is stored in the event
queue on the SQL server. One RightFax server will perform
maintenance when a maintenance event is queued, on a first-come,
first-served basis. Aging is performed before purging.

The default time for maintenance to begin is 2 AM. The time is set
in the RightFax Server Configuration dialog box, Advanced tab.

Viewing the Maintenance Logs

Logs of the maintenance process are stored in the
RightFax\Database folder on the server that performed the
process. These logs are:

e MaintAgingAndPurging.log
e MaintOrphanScan.log

¢ MaintDocRecovery.log
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Chapter 7
Upgrading and Adding Fax Channels,

User Licenses, and Optional Components

You can easily expand and extend the functionality of your RightFax To check for installed components

server by:
1. Run Enterprise Fax Manager (see “Using Enterprise Fax

« Upgrading the server (described on page 78) Manager” on page 33) and select the server you want to check.

» Adding fax channels and user licenses (described on page 79) 2. In the list of services in the lower-right pane, double-click

RightFax Server Module. The RightFax Server Configuration
Most of these additions to your fax server can be made without window opens.

installing or re-installing software. You can add new functionality to

all RightFax servers using “bump codes” Bump codes are special

activation codes that enable specific functionality on the server.

Bump codes are provided by Captaris support engineers or your

RightFax distributor, as described in this chapter.

« Adding optional components (described on page 80)

Checking for Installed Components

The different types of RightFax servers are installed with different
numbers of licensed fax channels and users, and different optional
components enabled. Follow these steps to display a list of the fax
channels, users, and components that have been enabled on the
server.
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3. Click the Feature Activation tab. The server type, number of
licensed fax channels and users, and enabled components are
listed in the window on this tab.

Figure 7.1 The List of Enabled RightFax Components

.| server Configuration, Base Level, Yersion 9.00 21

Ganerall tdvanced Feature Activation | Custam Messagesl User Messagasl Lidrain Massagesl eTransportI

Swstem expires: Wednesday, September 15, 2004
Licensed for 1 channel
Masimum of 2 users
Dermanstration copy
Business Server

Enter the Sysem |dentifier: I 0100
The 32 digit code ta GIVE ta T echnical Suppart: I Get Bump

Enter the 32 digit code GIVEN to you: I
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Upgrading the RightFax Server

Captaris RightFax servers can support small, medium, and large
enterprises. The following servers are available.

Table 7a RightFax Server Types

RightFax
server

Description

Business server

This RightFax server supports unlimited user accounts, It
includes one fax channel, and is expandable to 30 fax
channels.

Cancel |

Enterprise
server

This RightFax server supports unlimited user accounts. It
includes three WorkServers and one fax channel,
expandable to support unlimited fax channels. This server
includes the RightFax Web Client™ and the OCR
Router™, OCR Converter™, Docs-on-Demand™, and
TeleConnect™ modules.

The Enterprise server is also available as a product suite
that includes the RightFax Enterprise server, plus the
Gateway for Microsoft® Exchange, the Gateway for Lotus
Notes®, the Document Management Connector™, and the
SNMP Alerting™, and PDF modules.

Integration
server

The RightFax server and the RightFax Integration Module
enable applications for information exchange. The
Integration Module integrates RightFax with applications
on mainframe, mid-range, and local area network host
systems.

The RightFax Business Integration Module can be
installed on the RightFax Business and Enterprise servers.

The RightFax Enterprise Integration Module can be
installed on the RightFax Enterprise server.

Satellite server

This RightFax server supports up to 15 user accounts. It
includes two WorkServers and two fax channels.
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To upgrade the RightFax server

1.

Contact your RightFax distributor and purchase the appropriate
server license. You will be sent a new license card that includes
a new product serial number. In some cases, you may also
receive a new CD, which will require an additional installation as
described in the product’s user guide.

Run Enterprise Fax Manager (see “Using Enterprise Fax
Manager” on page 33) and select the server that you want to
upgrade.

In the service name list in the lower-right pane, double-click
RightFax Server Module. The RightFax Server Configuration
window opens.

Click the Feature Activation tab.

5. In the Enter the System ldentifier field, enter the RightFax

system ID that was provided with your RightFax server software.
Do not enter the product serial number, which is a separate
identifier.

Click Get Bump. The RightFax service will be stopped, and a
bump code will be displayed. Be prepared to provide this bump
code to a Captaris support engineer.

Call the RightFax product support group at (520) 320-7070.

Important Some RightFax service plans require that you contact
your RightFax distributor for bump codes rather than the RightFax
support group. If so, you must contact your distributor at the phone
number that was provided as part of your service agreement.

From the voice menu, select the option for support with a
Captaris faxing product, and then select the option for a bump
code. Your call will be routed to a support engineer.

Follow the instructions provided by the support engineer for
upgrading your server. You will be provided with a new bump
code to enter in the Feature Activation tab.

Adding Fax Channels and User Licenses

To add fax channels

. Contact your RightFax distributor and purchase the appropriate

channel or user license. You will be sent a new license card that
includes a new product serial number.

. Run Enterprise Fax Manager (see “Using Enterprise Fax

Manager” on page 33) and select the server to which you are
adding channels or user licenses.

. In the service name list in the lower-right pane, double-click

RightFax Server Module. The RightFax Server Configuration
window opens.

. Click the Feature Activation tab.
5. Click Get Bump. The RightFax service will be stopped, and a

bump code will be displayed. Be prepared to provide this bump
code to a Captaris support engineer.

. Call the RightFax product support group at (520) 320-7070.

Important Some RightFax service plans require that you contact
your RightFax distributor for bump codes rather than the RightFax
support group. If so, you must contact your distributor at the phone
number that was provided as part of your service agreement.

From the voice menu, select the option for support with a
Captaris faxing product, and then select the option for a bump
code. Your call will be routed to a support engineer.

. Follow the instructions provided by the support engineer for

upgrading your server. You will be provided with a new bump
code to enter in the Feature Activation tab.
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9. After you have added the new fax channels or user licenses,
they must be configured for use by RightFax. New fax channels
are configured in the BoardServer configuration program. New
users are configured in Enterprise Fax Manager. For information
on running the BoardServer configuration program or Enterprise
Fax Manager, refer to the RightFax Administrator’s Guide.

Licensing Brooktrout SR140 Channels

The Brooktrout License Manager, provided by Brooktrout allows
you to self-active your SR140 license key. Instructions and an
activation wizard are included with Brooktrout License Manager.
Using this method requires an active internet connection.
Alternatively, you may activate your SR140 channels by contacting
RightFax technical support at (520) 320-7070. A support
representative will guide you through the activation process.

Important To activate your SR140 channels, you must have an SR140
license card. This card contains your SR140 license key and is included
with the purchase of SR140 channels.

To open Brooktrout License Manager
1. Click the Windows Start button > Programs List > Cantana
License Manager. The Brooktrout License Manager opens.

2. Activation instructions can be found by clicking ? along the
Brooktrout License Manager toolbar.

RightFax 9.3 Feature Pack 1 Installation Guide

Enabling New RightFax Optional Components

To enable new RightFax components

1. Contact your RightFax distributor and purchase the appropriate
component license. You will be sent a new license card that
includes a new product serial number.

2. Run Enterprise Fax Manager (described in the RightFax
Administrator’s Guide) and select the server to which you are
adding the new component.

3. In the service name list in the lower-right pane, double-click
RightFax Server Module. The RightFax Server Configuration
window opens.

4. Click the Feature Activation tab.

5. Click Get Bump. The RightFax service will be stopped, and a
bump code will be displayed. Be prepared to provide this bump
code to a Captaris support engineer.

6. Call the RightFax product support group at (520) 320-7070.

Important Some RightFax service plans require that you contact
your RightFax distributor for bump codes rather than the RightFax
support group. If so, you must contact your distributor at the phone
number that was provided as part of your service agreement.

7. From the voice menu, select the option for support with a
Captaris faxing product, and then select the option for a bump
code. Your call will be routed to a support engineer.

8. Follow the instructions provided by the support engineer for
upgrading your server. You will be provided with a new bump
code to enter in the Feature Activation tab.
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9. After you enter the new bump code, the new RightFax
component(s) will be available. For information on configuring
and using RightFax components, refer to the documentation for
your particular products.
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Chapter 8
Documentation and Support

RightFax Documentation

Documentation for the RightFax server, the RightFax client
applications, and all of the RightFax components and modules is
installed in PDF format on the RightFax server.

All of the RightFax user guides are located in the RightFax\Docs
folder on the RightFax server and on the product CD. In addition,
most of these documents can be downloaded from the RightFax
Web site at
http://www.captaris.com/support/documentation/rightfax/index.ht
ml.

The following table describes all of the user guides available for
RightFax and lists the RightFax components that each guide

supports.

Note To view these files, you must have Adobe Acrobat Reader
installed. A copy of Adobe Acrobat Reader can be found on the RightFax
server installation CD in the Docs folder.

Table 8a RightFax User Guides

Guide name

Description

Activating and Using
PDF Module

A guide to installing, configuring, and using the
RightFax PDF Module.

Activating and Using
the OCR Converter
Module

A guide to installing, configuring, and using the
RightFax OCR Converter Module.

Activating and Using
the OCR Router
Module

A guide to installing, configuring, and using the
RightFax OCR Router Module.

Administrator's
Guide

A comprehensive guide to configuring and
maintaining all RightFax servers.

API Reference Guide

A reference for C programmers and Visual Basic
programmers for using the RightFax APL. This guide
is only available through the RightFax Developer’s
Network.
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Table 8a RightFax User Guides (Continued)

Guide name

Description

Client for Lotus
Notes Quick
Reference Card

A reference card for users who will send and manage
faxes with the RightFax Gateway for Lotus Notes.

Client for Microsoft
Outlook Quick
Reference Card

A reference card for users who will send and manage
faxes with the RightFax Gateway for Microsoft
Exchange.

COM Reference
Guide

A guide to using the RightFax COM module for
creating custom RightFax applications with Visual
Basic. This guide is provided in PDF format on the
RightFax COM Module installation CD.

Connector for Oracle
CRM Guide

A guide to installing, configuring, and using the
RightFax Connector for Oracle CRM.

Connector for Oracle
E-business Suite
Guide

A guide to installing, configuring, and using the
RightFax Connector for Oracle E-business Suite.

Connector for FileNet
P8 Guide

A guide to installing, configuring, and using the
RightFax Connector for Panagon Image Services.
This guide is only available with the FileNet P8
integration software.

Connector for SAP
R/3 Guide

A guide to installing, configuring, and using the
RightFax Connector for SAP R/3.

Docs-on-Demand
Guide

A guide to installing, configuring, and using RightFax
Docs-on-Demand.

Document
Management
Connector Guide

A guide to integrating RightFax with iManage and
Hummingbird content management applications.

Fax Board Guide

A guide to all the fax boards supported by RightFax,
including required hardware and software
configuration.

FaxUtil Quick
Reference Card

A reference card for users who will send and manage
faxes with RightFax FaxUstil.
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Table 8a RightFax User Guides (Continued)

Guide name Description
RightFax Lotus Notes | A guide to installing, configuring, and using the
Module Guide RightFax Lotus Notes Module.

RightFax Microsoft
Exchange Module
Guide

A guide to installing, configuring, and using the
RightFax Microsoft Exchange Module.

Installation Guide

A guide to installing the RightFax server, upgrading
the server, and adding new components.

Installing and Using
the InterAction
Integration Software

A guide to configuring RightFax to work with the
InterAction contact management system.

Integration Module
Guide

A guide to installing, configuring, and using the
RightFax Integration Module.

InternetLink Module
Guide

A guide to installing, configuring, and using the
RightFax InternetLink Module.

SecureDocs Module
Guide

A guide to installing, configuring, and using the
RightFax SecureDocs Module.

SNMP Alerting
Module Guide

A guide to installing, configuring, and using the
RightFax SNMP Alerting Module.

TeleConnect Guide

A guide to installing, configuring, and using RightFax
TeleConnect.
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Getting Help Online

Most of the RightFax windows and dialog boxes include
context-sensitive help. Typically, this help describes each field and
option in a dialog box. This context-sensitive help can be launched
from the question mark icon in the title bar of a dialog box.

Click the
question mark icon

e Click this icon, and then click any option on the dialog box to view
its definition.

e Or, press F1 to view a definition.
Online help for tasks or conceptual topics also is available. View

this help by selecting the Help menu. You can browse the help for
a topic or use the index to look up key words and terms.

. RightFAX FaxUtil

File Fax List Tools | Help

g ﬁl |@ - Contents X Select the

Errors Help menu

Speedy [RIGHTF, Conkact: Information

£ Main Aok,
LT Teach

The RightFax Web site offers the latest product information.
Updated documentation, a searchable customer support
knowledgebase, software downloads, and the latest product
offerings are all online at www.captaris.com/rightfax.

Editing Contact Information in FaxUtil

In the FaxUtil Help menu, users can select Contact Information,
and a dialog box opens that lists RightFax technical support
contact information.

Figure 8.1 The Contact Information Dialog Box
x

Tareach RightF ax technical suppart, call (520] 320-7070 -
tdonday through Friday 5:00 A k. to 5:00 P.¢.
or Saturday 7:00 A M. to 3:00 P.M. Pacific time.

Flease provide the follawing information:

- Compary name, phone number, and support plan
number [or invoice number and date)

- RightFax product, version, and registration number.

- Type of fax board [brand, model number, and serial
number].

- Type of computer, operating systemdenviranment,
network. and amount of memony.

- A concise description of the nature of the problem. If
possible, provide a scenario that can be uged to
reproduce the problem.

|

This contact information appears in English with RightFax contact
information, but you can edit the text to provide customized
information. To do so, edit the text file Contact.txt located in the
\RightFax\Bin folder on the RightFax server. You can enter 24 lines
of text and up to 59 characters per line.

Captaris Training Services

RightFax training gives you the skills to optimize your RightFax
solution. Our comprehensive technical, administrative, and user
training programs produce full utilization and understanding of
RightFax products. Regular classes are held at the state-of-the-art
RightFax Training Center in Tucson, Arizona, throughout the year, or
you can choose the convenience of training at one of our regional
locations. Training materials and computer-based training tools are
also available. For more information on RightFax training, please

Chapter 8 Documentation and Support

85



RightFax 9.3 Feature Pack 1 Installation Guide 86

visit our Web site at www.captaris.com/training, or call us at RightFax Customer Support:

(520) 320-7098 and let us help you develop a customized training . _

plan for your organization. Ca.ptans Voice: (520) 320-7070
Suite 210 Fax: (520) 321-7461
6303 E. Tanque Verde Web: www.captaris.com/rightfax
Tucson, Arizona 85715 USA E-mail: tech@captaris.com

Captaris Implementation Services

Captaris Implementation Services offers a team of highly skilled I .
engineers who are experts in the deployment, implementation, and 5:00 A.M. 10 5:00 PM. Pacific time, Monday through Friday
integration of RightFax solutions. Implementation services include 7:00 A.M. to 3:00 P.M. Pacific time, Saturday

installation and configuration, upgrades, configuration review, and
advanced integration services. Whether it's through remote dial-in,
an on-site implementation, or a combination of both, the
Implementation Services team can quickly integrate RightFax
solutions with your existing applications. s = =

Support Sales and Administration: (520) 320-7000

Customer Support

Your Customer Support Guide includes detailed information about
the support options available to RightFax customers. Please fill out
the RightFax Software Warranty & Registration Card and return it
immediately. If you have questions of a technical nature, contact
your organization's RightFax administrator or network administrator
before calling the RightFax customer support department. On the
RightFax Web site, a database of customer support knowledge
contains a wealth of information on installing, configuring, and
maintaining RightFax software.
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